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Chapter 1

Installing in a UNIX or Linux Environment

This section includes the following topics:

✦ Preinstallation Setup Checklist for a UNIX or Linux Environment on page 6
✦ Installing in a UNIX or Linux Environment on page 21
✦ Postinstallation in a UNIX or Linux Environment on page 37
✦ Uninstalling Gentran Integration Suite from a UNIX or Linux Environment on page 42
✦ Troubleshooting: UNIX or Linux Environment on page 43

Preinstallation Setup Checklist for a UNIX or Linux 
Environment
The following topics will assist you with preinstallation tasks when planning to install Gentran Integration 
Suite in a UNIX or Linux environment:

✦ Key Terms on page 7
✦ Checklist for UNIX or Linux Preinstallation on page 7
✦ Checking System Requirements on page 12
✦ Installing the Java 2 Software Development Kit on page 12
✦ Downloading the JCE Distribution File on page 12
✦ Determining Port Numbers on page 13
✦ Creating a UNIX Account on page 13
✦ Creating and Configuring the Database Server on page 13
✦ Obtaining a License File on page 19

✦ Silent Installation on page 21
Sterling Commerce, Inc. 6



Preinstallation Setup Checklist for a UNIX or Linux Environment
Key Terms
The following terms and definitions will assist you in understanding the concepts discussed in this 
document:

✦ Java 2 Software Development Kit (JDK) – Software development kit (SDK) for producing Java 
programs. Produced by Sun Microsystems, Inc., the JDK includes JavaBeans component architecture 
and support for JDBC.
Note: The Gentran Integration Suite System Requirements include information about upgrading your 
JDK for the changes enacted in 2007 for Daylight Savings Time.

✦ Gentran Integration Suite License File – Contains a license that is associated with your specific 
operating system and the IP address of your system. The license provides access, for a year, to the 
Gentran Integration Suite packages your company selected. 

✦ The Java Cryptography Extension (JCE) is a set of Java packages from Sun Microsystems, Inc. or IBM 
that provides a framework and implementations for encryption, key generation and key agreement, and 
Message Authentication Code (MAC) algorithms. 

✦ Unlimited Strength Policy File – another name for the Java Cryptography Extension (JCE).
✦ Rollback Segment – Enables you to undo (rollback) DML (data manipulation language) transactions 

that were made against a database. In Oracle version 9i or later, you can perform this task with Undo 
tablespaces.

Checklist for UNIX or Linux Preinstallation
The preinstallation checklist contains the items you need to gather and tasks you need to complete prior to 
installing Gentran Integration Suite. 

Note: When creating a name, such as an account name, permissions name, profile name, or database name, 
follow these conventions:

Use any valid alphanumeric characters and _ (underscore).

Do not use spaces or apostrophes.

You may want to make a copy of the following checklist and use it to record the information you collect for 
installing Gentran Integration Suite:

Step Description Your Notes

1 Verify that your system meets the hardware and software 
requirements specified for this release. See Checking 
System Requirements on page 12.

2 Verify that your system has the patches required by 
Java™ for the operating system that will run Gentran 
Integration Suite. See Checking System Requirements 
on page 12.
Note: For HP, you must run the HP JConfig utility to 

obtain the required patches and kernel 
modifications.
Sterling Commerce, Inc. 7



Preinstallation Setup Checklist for a UNIX or Linux Environment
3 For the AIX 5.2 and 5.3 operating systems, establish 
these settings:

Use the following command to change the ARG/ENV 
list size in 4K byte blocks kernel parameter to 12:

Note: “chdev” is followed by a minus sign.

chdev -l sys0 -a ncargs=12

In some cases, ncargs may already be higher than 
12. To find out the current value of ncargs, use this 
command:
lsattr -El sys0 -a ncargs

Change the following default entries in the 
/etc/security/limits file:
fsize = -1
core = 2097151
cpu = -1
data = 262144
rss = 65536
stack = 65536
nofiles = 4096 (recommended value is unlimited)

Step Description Your Notes
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Preinstallation Setup Checklist for a UNIX or Linux Environment
4 For the RedHat Enterprise Linux operating system only, 
make the following system changes:

1 If the base locale for the system is English, edit 
the /etc/sysconfig/i18n file by changing the 
following variables:

• Change LANG from en_US.utf8 to en_US.
• Change SUPPORTED from en_US.utf8 to 
en_US. You can also allow multiple support using 
the following format:

en_US.utf8:en_US

Save and close the /etc/sysconfig/i18n file.
2 Edit the /etc/security/limits.conf file by adding the 

following lines:
gisuser hard    nofile  8196

gisuser soft    nofile  4096
gisuser hard    memlock 3000000

gisuser soft    memlock 3000000

gisuser hard    nproc   16000
gisuser soft    nproc   16000

gisuser hard    stack   512000

gisuser soft    stack   512000

This updates the system ulimits.
Note: For nofile, the recommended value is 
unlimited.
Save and close the /etc/security/limits.conf file.

3 Reboot the system.

Step Description Your Notes
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Preinstallation Setup Checklist for a UNIX or Linux Environment
5 For the SUSE Linux operating system only, make the 
following system changes:

1 If the base locale for the system is English, edit 
the /etc/sysconfig/language file by changing the 
following variables:

Change RC_LANG from en_US.UTF8 to en_US.
Save and close the /etc/sysconfig/language file.

2 Edit the /etc/security/limits.conf file by adding the 
following lines:
gisuser hard    nofile  8196
gisuser soft    nofile  4096

gisuser hard    memlock 3000000

gisuser soft    memlock 3000000
gisuser hard    nproc   16000

gisuser soft    nproc   16000

gisuser hard    stack   512000
gisuser soft    stack   512000

This updates the system ulimits.
Note: For nofile, the recommended value is 
unlimited.
Save and close the /etc/security/limits.conf file.

3 Reboot the system.

6 For systems with multiple IP addresses, verify that the IP 
address on which Gentran Integration Suite resides is 
accessible by any client computer that is running a 
browser interface.
For all Linux operating systems only, ensure that 
/etc/hosts has short-names first for all entries. For 
example, 127.0.0.1localhostlocalhost.localdomain
Caution: If you do not verify the IP addresses, your 
system may not operate properly after installing Gentran 
Integration Suite.

7 Verify that all client computers are using Microsoft 
Internet Explorer 5.x or later.

8 If you are using a non-English environment, confirm that 
you are using the appropriate character set.

9 Determine and record information about the JDK. See 
Installing the Java 2 Software Development Kit on page 
12.

Version of the JDK

Absolute path to the JDK files and patches

Step Description Your Notes
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Preinstallation Setup Checklist for a UNIX or Linux Environment
10 Obtain the JCE distribution file and record the absolute 
path to the zipped file. See Downloading the JCE 
Distribution File on page 12.

11 Determine and record the initial port number to be used 
by Gentran Integration Suite. See Determining Port 
Numbers on page 13.

12 Verity that a UNIX user account exists on the host server 
for each installation of Gentran Integration Suite. See 
Creating a UNIX Account on page 13.

13 Set Umask to 002.

14 If you are using an Oracle, MS SQL, or DB2 database, 
determine and record information about your database 
server. Be aware that this information is case sensitive. 
See Creating and Configuring the Database Server on 
page 13.

Database vendor

Database user name and associated password

Database (catalog) name

Database host name

Database host port number

Absolute path and file name for the JDBC driver

Version of the JDBC driver

15 Determine and record information to set up default 
system alerts from Gentran Integration Suite:

The Administrative e-mail address to which system 
alert messages are sent. 

The SMTP Server IP address used for sending alert 
messages. 

16 Determine and record the directory in which you plan to 
install Gentran Integration Suite.

The installation directory must not exist because the 
installation process creates it. 

The file system must have adequate free disk space.

The name of the directory is case sensitive.

17 Determine and record the passphrase you want to use 
for the Gentran Integration Suite system. 
During installation, you are prompted twice to type the 
passphrase, which is not displayed when you type it. 

Step Description Your Notes
Sterling Commerce, Inc. 11



Preinstallation Setup Checklist for a UNIX or Linux Environment
Checking System Requirements
Before you begin, verify that your system meets the hardware and software requirements specified for this 
release. The hardware requirements listed are the minimum required to run Gentran Integration Suite. Your 
system requirements will exceed these if you are running other applications on the same machine as Gentran 
Integration Suite.

For current information, see the System Requirements posted on the Gentran Integration Suite 
Documentation Library.

Note: Version 4.2 of Gentran Integration Suite does not require an application server for installation or at 
run-time. However, Gentran Integration Suite supports integration with JBoss™ and WebLogic®. 
You can also integrate with WebSphere®, JBoss, or WebLogic after installing version 4.2 by using 
the Gentran Integration Suite EJB Adapter.

Installing the Java 2 Software Development Kit
You must install the Java 2 Software Development Kit (JDK) and the patches specific to your system. To 
determine which JDK version and patches you need, see the Gentran Integration Suite System Requirements. 
After you install the JDK, record the absolute path to its location on your system. You must supply the 
absolute path when you install Gentran Integration Suite.

Note: The System Requirements include information about upgrading your JDK for the changes enacted in 
2007 for Daylight Savings Time.

Downloading the JCE Distribution File
The Java Cryptography Extension (JCE) is a set of Java packages from Sun Microsystems, Inc. or IBM that 
provides a framework and implementations for encryption, key generation and key agreement, and Message 
Authentication Code (MAC) algorithms.

To obtain this file for the Sun JDK 1.4 (Solaris and HP-UX):

1. Open your browser and navigate to http://java.sun.com/products/jce/index-14.html.
2. At the bottom of the page, locate the section Downloading the "Unlimited Strength" Jurisdiction 

Policy Files and click Download JCE Unlimited Strength Jurisdiction Policy Files.
3. Download the zipped JCE 1.4.2 distribution file to your system. Once the file resides on your system, 

note the exact directory and file name for this zipped file.

To obtain this file for the IBM JDK 1.4 (RedHat, AIX, and SLES)

18 Obtain the license file and record the absolute path and 
file name to the license file. Be sure that the path name 
and the file name consist of alphanumeric, “.”, “_” and “-” 
characters. See Obtaining a License File on page 19.

Step Description Your Notes
Sterling Commerce, Inc. 12
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1. Open your browser and navigate to 
https://www14.software.ibm.com/webapp/iwm/web/reg/pick.do?source=jcesdk.

2. Enter your IBM ID and password. If you do not have an IBM ID, follow the IBM registration 
instructions provided on the Sign In page.

3. Click Submit.
4. Select Unrestricted JCE Policy files for SDK 1.4.2 and click Continue.
5. Review your personal information and the license agreement and click I agree to continue.
6. Download the unrestrict142.zip file to your system. 
7. Once the file resides on your system, note the exact directory and file name for this zipped file. You 

will need this information during the installation process.

Determining Port Numbers
During installation, you are prompted to specify the initial port number for Gentran Integration Suite. 

To specify an initial port number, follow these guidelines:

✦ Gentran Integration Suite requires a range of 100 consecutive open ports between 1025 and 65535. 
✦ The initial port number represents the beginning port number in the range. 
✦ The port range starts with the initial port number and ends with the number that equals the initial port 

number plus 100. All ports in this range must be available for Gentran Integration Suite. For example, 
if you specify 10100, then you need to make sure that 10100 through 10199 are not used by any other 
applications on your system. 

For the other ports after the initial port, you can accept the default port number suggested by the installation 
program, or you can individually re-assign pre-assigned default port numbers within the specified port 
range. During installation, about 50 default ports are pre-assigned for different services. For example, if you 
do not want xxx32 (10132) to be a default port, you could assign that port to xxx97 or another number within 
the port range.

Creating a UNIX Account
In a UNIX or Linux environment, you must create a UNIX administrative account on the host server for 
each installation of Gentran Integration Suite. For example, if you want to create a test environment and a 
production environment, you need to create two UNIX accounts on the host server, one for the test and one 
for the production environment. For more information about creating UNIX accounts, see your operating 
system documentation. 

Creating and Configuring the Database Server
You must install, create, and configure a database so that each Gentran Integration Suite instance has a 
dedicated schema and login for the database.

Caution: If you are reinstalling Gentran Integration Suite, be aware that data in your existing database will 
be deleted. To prevent this, either back up the existing database or save it under a different name.
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After creating and configuring your database, recycle the database. Then stop and restart Gentran 
Integration Suite to apply the changes.

In a UNIX/Linux environment, Gentran Integration Suite supports the following databases: 

✦ MySQL™  (See Using a MySQL Database Server on page 14)
✦ Oracle® 9i or 10g (See Using an Oracle Database Server on page 14)
✦ DB2 (See Using a DB2 Database Server on page 17)
✦ MS SQL (See Using a Microsoft SQL Server Database Server on page 18)
See System Requirements for supported version information.

Using a MySQL Database Server
You can use a MySQL database server with Gentran Integration Suite. See System Requirements for version 
information. This database is bundled with Gentran Integration Suite. Choosing this database during the 
installation procedure creates and configures it for you. MySQL is installed locally on the same server as 
Gentran Integration Suite and cannot be installed on a separate server.

Using an Oracle Database Server
You can use an Oracle 9i or 10g database with Gentran Integration Suite. See System Requirements for 
supported version information. Gentran Integration Suite supports Oracle 10g in a single node database 
environment.

Note: Oracle 10g RAC is not supported in Gentran Integration Suite 4.2.

To use an Oracle 9i or 10g database, follow this process:

✦ Create the database. Refer to your vendor’s documentation for information about creating the 
database, including creating a schema repository, login, and tablespace. Be sure to install the correct 
version and patches. 

✦ Configure the database by completing the following tasks: 
Setting Database Parameters in Oracle on page 14

Rolling Back or Undoing Changes in Oracle on page 15

Granting Permissions in Oracle on page 15

Installing the JDBC Driver in Oracle on page 16

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (UNIX/Linux) on page 16

Setting Database Parameters in Oracle

Gentran Integration Suite requires the following parameter settings in your Oracle database:

Parameter Value

Number of open cursors greater than or equal to 2000
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Rolling Back or Undoing Changes in Oracle

You can roll back or undo changes in Oracle using one of the following methods:

✦ (Oracle versions earlier than 9i) Gentran Integration Suite recommends that you configure a rollback 
segment for every four concurrent users. Each rollback segment must be extendable to 25MB. The 
value of the initial segment and the next segment can vary between 256 KB (with 5MB for optimal) 
and 10 MB (with 20 optimal). Note that these ranges will vary based on the size of your Gentran 
Integration Suite database and the number of business rules it contains.

✦ (Oracle versions 9i or later) These versions support AUTO UNDO management. It is recommended 
that you use this option. This will avoid any manual monitoring of UNDO segments.
If a server is upgraded from Oracle 8i, set the UNDO_MANAGEMENT=AUTO parameter in 
init<SID>.ora. Your database administrator needs to determine the UNDO_RETENTION setting. 
Ensure that the file system which has the UNDOTBS1 tablespace has enough space to use the 
AUTOGROW setting.

Granting Permissions in Oracle

Grant the following permissions to the Gentran Integration Suite user:
GRANT "CONNECT" TO <USER>
GRANT SELECT_CATALOG_ROLE TO <USER>
ALTER USER <USER>DEFAULT ROLE "CONNECT",

SELECT_CATALOG_ROLE
GRANT CREATE PROCEDURE TO <USER>
GRANT CREATE TRIGGER TO <USER>

Database block buffers greater than or equal to 19200
Note: Sterling Commerce recommends that this be set to 0 if 

SGA memory equals greater than 0.

System Global Area (SGA) 
memory (10g only)

greater than 0
Note: Sterling Commerce recommends that the database 

block buffers be set to 0 if SGA memory equals greater 
than 0.

Shared pool size greater than or equal to 90000000

Large pool size greater than or equal to 614400

Java pool size greater than or equal to 20971520

Number of processes greater than or equal to 500

Log buffer greater than or equal to 163840

Database block size greater than or equal to 8192

Sort area size greater than or equal to 65536

Sort area retained size greater than or equal to 65536

Max extends Unlimited

Character set AL32UTF8

Parameter Value
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GRANT CREATE TYPE TO <USER>
GRANT EXECUTE ANY PROCEDURE TO <USER>
GRANT EXECUTE ANY TYPE TO <USER>
GRANT SELECT ANY TABLE TO <USER>
GRANT SELECT ANY DICTIONARY TO <USER>

For Oracle 10g 10.2.x, also grant the following permission:
GRANT "RESOURCE" TO <USER>;
ALTER USER <USER> DEFAULT ROLE "CONNECT","RESOURCE",SELECT_CATALOG_ROLE;

Note: If you are using Oracle AQ for Oracle 9i or Oracle 10g, then grant the 
AQ_ADMINISTRATOR_ROLE permission.

Installing the JDBC Driver in Oracle

Gentran Integration Suite requires the appropriate JDBC driver for Oracle Database 10g and Oracle 9i 
databases. These drivers are thin client based pure Java JDBC drivers. See System Requirements for 
supported version information.

The supported versions of the JDBC driver will build the correct Gentran Integration Suite directory 
structure.

After obtaining the correct JDBC driver, record the absolute path to its location on your system. You must 
supply this absolute path when installing Gentran Integration Suite.

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (UNIX/Linux)

To enable failover in a multiple node Oracle RAC database cluster in UNIX/Linux, do the following:

1. Navigate to the install_dir/install/properties directory to modify sandbox.cfg file.
2. In the sandbox.cfg file, add a new property for ORACLE_JDBC_URL, which contains the Oracle 

RAC connection URL.
The following example shows the suggested URL form and the way it is organized. However, the 
property value must be one string of text starting with ORACLE_JDBC_URL=. Your database 
administrator (DBA) can modify this URL as needed.
jdbc:oracle:thin:@

  (DESCRIPTION=

    (ADDRESS_LIST=

      (FAILOVER=ON)

      (LOAD_BALANCE=ON)

      (ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))

      (ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))

     )

     (CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME = myservicename))

   )

3. Run the setupfiles.sh command from the install_dir/install/bin directory.
4. Set the propagation delay on the RAC server to 0.
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Using a DB2 Database Server
You can use a DB2 database with Gentran Integration Suite. See System Requirements for supported version 
information. To use a DB2 server, follow this process:

✦ Create the database. Refer to your vendor’s documentation for information about creating the 
database, including creating a schema repository, login, and tablespace. Be sure to install the correct 
version and patch. Be sure to install the client components and compilers before you install the 
fixpack.

✦ Configure the database by completing the following tasks:
Installing Client Components, Compilers, and Fix Pack on page 17

Setting Parameters for DB2 on page 17

Granting Permissions for DB2 on page 17

Installing JDBC Drivers for DB2 on page 17

Installing Client Components, Compilers, and Fix Pack

Gentran Integration Suite uses stored procedures for DB2. You must install or set up the following 
components:

1. Install the Administration client. 
2. Install the Application Development clients.
3. Install the necessary fix pack after you install the client components and compilers. Otherwise, the 

clients will overwrite the fix pack binaries.
4. Set the path for the compiler by using the db2set command. 

For more information about these tasks, see the IBM documentation.

Setting Parameters for DB2

Gentran Integration Suite requires the following parameter settings in your DB2 database:

Granting Permissions for DB2

Grant DBADM permissions to the Gentran Integration Suite user.

Installing JDBC Drivers for DB2

Parameter Value

APPLHEAPSZ greater than or equal to 10000

APP_CTL_HEAP_SZ greater than or equal to 512

MAXAPPLS greater than or equal to 150

LOCKLIST greater than or equal to 30000

MAXLOCKS 100

Database code page UTF-8
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For DB2, Gentran Integration Suite requires the appropriate DB2 JDBC Type 4 driver and any correlating 
patches. See System Requirements for supported version information.

You can obtain these files from the IBM Web site. After you obtain this JDBC driver, record the absolute 
path to its location on your system. You must supply this absolute path when you install Gentran Integration 
Suite.

If the JDBC driver provided by your database vendor is distributed among multiple files, you must place all 
the files that comprise the JDBC driver into one jar file. Follow these steps to create one jar file:

1. Identify all the vendor database jar files for the JDBC driver.
2. Create a temporary working directory (mkdir wd; cd wd).
3. Extract the contents of each file used for the JDBC driver using the jar utility into the temporary 

working directory (jar xvf <jdbc.jar> for each supplied jar file).
4. Bundle the files in the temporary working directory into one file using the jar utility (jar 

cvf(6|new.jar)*). 
5. Record the absolute path to the jar file you created on the Preinstallation Checklist.

The type-4 driver does not require a separate Java listener running on the database server. Instead, connect 
directly to the DB2 port.

Using a Microsoft SQL Server Database Server

You can use a Microsoft SQL Server database with Gentran Integration Suite. See System Requirements for 
supported version information. To use an MS SQL Server database, follow this process:

✦ Create the database. Refer to your vendor’s documentation for information about creating the 
database, including creating a schema repository, login, and tablespace. Be sure to install the correct 
version and patch.

✦ Configure the database by completing the following tasks:
Setting Database Parameters in SQL Server on page 18

Granting Permissions in SQL Server on page 19

Installing the JDBC Driver in SQL Server on page 19

Setting Database Parameters in SQL Server

Gentran Integration Suite requires the following parameter settings in your SQL Server database:

Parameter Value

Collation Setting SQL_Latin1_General_CP850_BIN

Sort order Binary

Security authentication SQL Server and Windows

Torn Page Detection Off

Parallelism Use one processor (do not use all available 
processors)
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Granting Permissions in SQL Server

In SQL Server, you must grant DBO (Database Owner) permission to the Gentran Integration Suite user.

Installing the JDBC Driver in SQL Server

Gentran Integration Suite requires the correct Microsoft SQL Server driver. See System Requirements for 
supported version information. Go to http://www.microsoft.com/downloads to download this driver which, 
as of Gentran Integration Suite 4.2, is contained in a tarball named mssqlserver.tar. This tarball includes the 
jar files msbase.jar, mssqlserver.jar, and msutil.jar. Also download any appropriate patches. 

Uncompressing mssqlserver.tar yields several files, including install.ksh, which is a korn shell script that 
installs the JDBC drivers in a specified directory. 

After running the install.ksh script, you need to combine the three jar files that make up the Microsoft SQL 
Server JDBC drivers (msbase.jar, mssqlserver.jar, and msutil.jar). These files will be placed in the <JDBC 
Driver install dir>/lib directory.  To combine these jar files, use the following procedure:

1. Make a new directory in which you will work, and copy the separate jar files to this directory.
2. For each of the separate jar files, issue the following command:

jar -xvf <jar file name>

3. After all of the jars have been expanded, remove the META-INF directory that will be located in the 
working directory.

4. Create a new jar file by issuing the following command:
jar -cvf. <combinedJarName.jar> *

When the Gentran Integration Suite installation asks for the location of the JDBC drivers, specify the jar file 
you created with the above procedure.  The JDBC driver version is the same as the version of the drivers 
downloaded from Microsoft.

Obtaining a License File
After your company signed the sales contract with Sterling Commerce, Sterling Commerce created a license 
file containing information about your company, your system, and the packages (components), such as 
services, maps, and adapters, your company selected to use. 

The license file contains a license that is associated with your specific operating system and the IP address 
of your system. The license provides access, for 20 years from the date of issue, to the Gentran Integration 
Suite packages your company selected and is independent of your maintenance fee. Because the license is 
independent of your maintenance fee, the schedule for renewing your license and license file may be 
different than the maintenance fee schedule. 

You must download the license file before you can install Gentran Integration Suite. Follow these steps:

1. Point your Web browser to http://www.productupdates.stercomm.com.
2. Review the Welcome to Sterling Commerce Product Update page and click Next.
3. Review the Authenticate page and click Next.
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4. Type the License File Key, which is case-sensitive, and click Next. If the system displays the Retrieve 
Registration dialog box and you are upgrading, you may retrieve your registration information by 
entering your previous License File Key. If you are not upgrading, then click Next.

5. Verify the registration information and click Next.
6. On the Server Details page, update the fields and click Next.

If the operating system, application server, or database server version is not listed in the respective 
lists, type the version in the respective Description of Other.
All IP addresses assigned to the server in which you are installing Gentran Integration Suite should be 
listed in the license file.

7. Verify the list of packages and the type of license selected for each package and click Next. If the list 
of packages selected or the type of license selected is not correct, then contact Customer Support to 
correct the information.

8. Scroll to the bottom of the Review and Download Package License File page and click Finish and 
Download.

9. Click Save in the File Download dialog box.
10. Accept the default location for the license file or navigate to the location where you will store the 

license file. Note the absolute path of the file location on the Preinstallation Checklist. You will need 
the absolute path to install Gentran Integration Suite.

11. Click Save.
12. Close your Web browser.
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Silent Installation
You can set up an installation of Gentran Integration Suite so that it runs with no user interaction. For these 
silent installations, you need to create the following items for your installation script:

✦ A text file with information that during an interactive installation you are prompted to enter. This 
information is then automatically accessed by the installation script.
Examples of silent installation text file entries:
APSERVER_PASS = (system passphrase)

INSTALL_DIR = (full path to the installation directory)

LICENSE_FILE_PATH = (full path to the license file)

PORT1 = (initial port)

JCE_DIST_FILE = (full path to the JCE distribution file)

SI_ADMIN_MAIL_ADDR = (email address for administrative contact)

SI_ADMIN_SMTP_HOST = (SMTP mail server host name)

DB_VENDOR = (database)

ACCEPT_LICENSE = (license agreement acceptance)

DB_USER = (database user ID)

DB_PASS = (database password)

DB_DATA = ('net service name' or 'database name')

DB_HOST = (database hostname or IP address)

DB_PORT = (database's listener port.)

DB_DRIVERS = (fully qualified path to the database driver)

DB_DRIVERS_VERSION = (version of database drivers)

✦ A reference in your installation script to this variable file.
Example (single node installation or node 1 of a clustered installation):
install_dir/JDK/bin/java -jar GISxx.jar -f silent_install_file

Example (nodes 2 and higher of a clustered installation):
install_dir/JDK/bin/java -jar GISxx.jar -f silent_install_file -nodbinit

Installing in a UNIX or Linux Environment
Installing Gentran Integration Suite in a UNIX or Linux environment includes the following sections:

✦ Running the Installation Program in UNIX or Linux on page 22
✦ Installing a Cluster Configuration in UNIX or Linux on page 24
✦ Installing the Current Maintenance Patch in UNIX or Linux on page 29
✦ Installing Patches in a Perimeter Server Environment on page 31
✦ Installing Patches in a Clustered Environment on page 32
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✦ Installing a Hot-Fix in UNIX or Linux on page 34
✦ Encrypting Database Passwords on page 35
✦ Setting Up Perimeter Servers with Gentran Integration Suite on page 35
Caution: If you are upgrading, refer first to the Upgrade Guide for the release from which you are 

upgrading (3.0/3.1, 4.0 or 4.1/4.1.1). Upgrading from Gentran Integration Suite 3.0, 3.1 and 4.0 
includes a full installation of Gentran Integration Suite 4.2, but you must follow additional steps 
in the Upgrade Guide to complete the upgrade. Upgrading from Gentran Integration Suite 4.1 
and 4.1.1 does not include an installation of Gentran Integration Suite 4.2. 

Running the Installation Program in UNIX or Linux
Note: The following instructions assume that you received an installation CD for Gentran Integration 

Suite. If you downloaded Gentran Integration Suite or a Service Pack (SP) from the Electronic 
Software Distribution (ESD) Portal, unzip the downloaded file to an empty directory. The directory 
containing the unzipped files is an electronic image of an installation CD. Use this directory 
wherever there is a reference to the installation CD in the following instructions. Ignore any 
instructions to place the installation CD in a drive.

To install Gentran Integration Suite in a UNIX or Linux environment, refer to your preinstallation checklist 
and follow the steps below.

Note: During the installation, various messages are displayed, including some warning messages. These 
warning messages require no action on your part and are included so that helpful data is recorded in 
the log file.

1. Place the Gentran Integration Suite 4.2 installation CD in the appropriate drive.
2. From the installation CD, copy si42.jar to your home directory or base directory and change to that 

directory.
If you are using FTP to copy the files, verify that your session is set to binary mode.

3. To begin the installation, type the absolute path to the JDK followed by one of the following 
commands:

If you are installing a new Gentran Integration Suite system, enter:
/absolutePath/bin/java -jar si42.jar 

The program verifies the version of your operating system, the JVM version, and the required 
operating system patch levels.

If you are upgrading from Gentran Integration Suite version 4.0.3-5 or higher to Gentran 
Integration Suite version 4.2, enter:
/absolutePath/bin/java -jar si42.jar -nodbinit

If the Gentran Integration Suite system is running, stop the previous installation before proceeding.
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If you are upgrading from Gentran Integration Suite version 3.0 or 3.1 to Gentran Integration Suite 
version 4.2, and you are upgrading a single node installation or the first node of a cluster 
installation, enter:
/absolutePath/bin/java -jar si42.jar -upgrade

For more information about cluster installations, refer to Installing a Cluster Configuration in 
UNIX or Linux on page 24.

If you are upgrading the second and higher nodes of a cluster installation from Gentran Integration 
Suite version 3.0 or 3.1 to Gentran Integration Suite version 4.2, enter:
/absolutePath/bin/java -jar /absolutePath/si42.jar -nodbinit

For more information about cluster installations, refer to Installing a Cluster Configuration in 
UNIX or Linux on page 24.

Note: The command to upgrade from Gentran Integration Suite version 3.0 or 3.1 to Gentran Integration 
Suite version 4.2 does not automatically install patches. After you complete the upgrade from 
Gentran Integration Suite version 3.0 or 3.1 to Gentran Integration Suite version 4.2, you need to 
manually apply patches to complete the Gentran Integration Suite version 4.2 installation.
If the Gentran Integration Suite system is running, stop the previous installation before proceeding. 

4. The program checks for the presence of the JCE unlimited strength policy files. If they are not 
installed, you are prompted for the path to the JCE distribution file. If prompted, type the absolute path 
name to the JCE distribution file and press Enter. The program verifies the path name.

5. Type the absolute path for the license file and press Enter. The license file must reside on the local 
UNIX host. If you saved the license file to a Windows client, transfer the license file to the UNIX host. 

6. Enter the absolute path name for the installation directory and verify that the directory is correct. 
The program checks the amount of available disk space.

7. Change to the installation directory and run the command ./installSi.sh.
8. Review and accept the license agreement.
9. You are prompted whether to override the host IP address.

If Yes, enter the IP address you want to use.

If No, press Enter to accept the host IP address.

10. Type the system passphrase that you want to use. Then type the passphrase again to confirm it. 
11. Depending on your operating system, you may be asked if you want to integrate with WebLogic or 

JBoss. If prompted and you want to integrate, type yes and enter the required information. Otherwise, 
type no to continue.

12. Enter the initial port number for Gentran Integration Suite. The installation sets up subsequent ports 
based on the initial port number.
Note: The WebDAV port is set to the initial port number plus 46. For example, if the initial port is 
10000, the WebDAV port is 10046. You will need to know this port number if you plan to set up 
WebDAV support.

13. You are prompted whether to change the default port values.

To accept the default values, type no.
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To change the default values, type yes. You are prompted for each value. Press Enter to accept the 
displayed value, or type the new value and press Enter.

14. Type the administrative e-mail address to which you want system alert messages sent. 
15. Type the SMTP mail server host name that you want to use for system alert messages. 
16. You are prompted for the database you want to use.

If you are using MySQL, type 4. The MySQL bundled with Gentran Integration Suite will be 
installed local to Gentran Integration Suite on the same server.

If you are using Oracle, DB2, or MS SQL, type 1, 2, or 3 as appropriate. Enter the following 
information when prompted:
• Database user name
• Database password
• Database password again for confirmation
• Database (catalog) name
• Database host name
• Database host port number (For DB2, use port 50000)
• Absolute path and file name for the JDBC driver (For DB2, use the Type-4 JDBC driver)
• Version of the JDBC drivers

The installation program verifies the database connection. If a connection cannot be established, you 
receive an error and can re-enter the database information. 

17. Verify the information you entered. Then press Enter to continue. 
18. The installation process continues automatically and installs the following components:

MySQL (if you selected MySQL) 

Core files (services, adapters, and predefined business processes)

Package files

System certificates

License file

19. When installation is finished, the system displays the following message:
Installation has completed successfully. 
If you encounter problems or errors during installation, see Troubleshooting: UNIX or Linux 
Environment on page 43.

Installing a Cluster Configuration in UNIX or Linux
Installing Gentran Integration Suite nodes is similar to a standard Gentran Integration Suite installation, with 
the following restrictions on all nodes:

✦ All nodes must use the same database.
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✦ All nodes must use the same passphrase.
✦ You must install and start the nodes sequentially, one at a time, starting with the first node.
To install Gentran Integration Suite in a cluster configuration, do the following:

1. Install the first node (node1) as you would a single Gentran Integration Suite system. For more 
information, see Running the Installation Program in UNIX or Linux on page 22.

2. Install each subsequent node, from node2 onwards, by running the command java –jar si42.jar 
–nodbinit, using the "-nodbinit" option, which prevents any database initialization and update. The 
installation passphrase must be the same across all nodes.
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3. When prompted, change to the installation directory and run the command ./installSi.sh.
When the patch installation portion of the installation fails with the following message, go to the next 
step:
Note: The following failure error message applies only to Gentran Integration Suite 4.0. The failure 
error message does not appear for Gentran Integration Suite 3.x and 4.1. For those versions, go to the 
next step.
Controller loading lists...
Error '255' installing service files.
ERROR: Installation failed '255'
This error message writes the following information to the security.log file:
[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE Product version 
doesn't match feature set version.

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE LM.refresh caught 
securityexception

java.lang.SecurityException: Product version 4.1 does not match feature map 
version 4.2.0-42XX

        at com.company.security.lc.LM.loadMap(LM.java:2355)

        at com.company.security.lc.LM.refresh(LM.java:2908)

        at com.company.security.lc.LM.<clinit>(LM.java:3305)

        at 
com.company.server.install.module_loader.ServiceInstall.install(ServiceInst
all.java:184)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.doIt(ServiceI
nstallDriver.java:164)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.main(ServiceI
nstallDriver.java:63)

        at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method)

        at 
sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.java:3
9)

        at 
sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImp
l.java:25)

        at java.lang.reflect.Method.invoke(Method.java:324)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.doIt(Se
rviceInstallBootstrapper.java:94)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.main(Se
rviceInstallBootstrapper.java:58)

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE 
*************************************
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[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE License check 
failed at 0

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE 
*************************************

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE LM.refresh caught 
securityexception exit SI

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE LM.refresh caught 
securityexception at start up exit SI

java.lang.SecurityException: Product version 4.1 does not match feature map 
version 4.2.0-42XX

        at com.company.security.lc.LM.loadMap(LM.java:2355)

        at com.company.security.lc.LM.refresh(LM.java:2908)

        at com.company.security.lc.LM.<clinit>(LM.java:3305)

        at 
com.company.server.install.module_loader.ServiceInstall.install(ServiceInst
all.java:184)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.doIt(ServiceI
nstallDriver.java:164)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.main(ServiceI
nstallDriver.java:63)

        at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method)

        at 
sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.java:3
9)

        at 
sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImp
l.java:25)

        at java.lang.reflect.Method.invoke(Method.java:324)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.doIt(Se
rviceInstallBootstrapper.java:94)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.main(Se
rviceInstallBootstrapper.java:58)

4. On each node after node1, copy install_dir/bin/FeatureSet.xml from the primary node to 
install_dir/bin on the secondary node.

5. On each node after node1, change to the installation directory and run the command 
./installSi.sh.

6. On each node after node1, change the directory to install_dir/bin on the secondary node.
7. On each node after node1, install the patch on the secondary node using the following command:

InstallService.sh absolutepath/si_engine_4204.jar (or higher)
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8. On each node, starting with node1, perform cluster configuration by running the command 
"startCluster.sh nodeNumber" from the Gentran Integration Suite install_dir/bin directory where 
nodeNumber is the sequential number assigned to each node starting with 1.  

To make a dynamic addition of new nodes to the cluster, install new nodes to the cluster using the 
"-nodbinit" option as described above and configure the servers for the cluster.

Gentran Integration Suite supports the installation of multiple nodes on the same machine. Each node will 
be configured on a different port range. To install Gentran Integration Suite in a cluster configuration on the 
same machine, do the following:

1. Install the first node (node1) as you would a single Gentran Integration Suite system. For more 
information, see Running the Installation Program in UNIX or Linux on page 22.

2. Install each subsequent node, from node2 onwards, using the “-nodbinit” option, which prevents any 
database initialization and update. The installation passphrase must be the same across all nodes. 
Update the FeatureSet.xml file on each subsequent node. Install each node in the same machine on a 
different port range 

3. Once the installation and cluster setup is complete, go to the properties directory of the installed nodes 
and change the multicastBasePort property in noapp.properties to point to node1’s 
"multicastBasePort".

Custom Configurations
As part of a default cluster configuration, certain values in the database for service or adapter configurations, 
default document storage type, etc., are updated to get the cluster working. The default settings include no 
shared or mounted file system available with “line of sight” from all cluster nodes, etc. Certain service or 
adapter configurations are forcibly deployed on node1 and default document storage type is set up to 
“Database” for all business processes.

After you install the cluster and evaluate the customer configurations and requirements, the above 
conditions might change and custom configurations will be incorporated. To keep these custom 
configuration changes from being overwritten, the following cluster configuration script has an option to 
update the database:

startCluster.sh nodeNumber true/false

✦ nodeNumber is the cluster node number
✦ Type true to perform database update and false to prevent any database updates.
The first time you configure a Gentran Integration Suite cluster, run startCluster.sh with the database update 
option set to true to have all cluster-related configurations take effect.

startCluster.sh nodeNumber true

For cluster configurations after the first configuration, you can execute the startCluster.sh command with 
the database update option turned off. This prevents any configuration changes from affecting the system, 
especially after installing patches/hot-fixes.

startCluster.sh nodeNumber false
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Multicast Configurations
All Gentran Integration Suite cluster nodes communicate with each other through multicast on a specific IP 
address and port. The multicast ports are configured based on the Gentran Integration Suite installation base 
port. All Gentran Integration Suite clusters that are on the same subnet configured on the same Gentran 
Integration Suite base port will end multicasting messages on the same multicast IP address and port. 

To avoid this, each Gentran Integration Suite cluster on the same subnet needs to be configured on different 
base ports.  Install your clusters on different port ranges or on different network segments with multicast 
forwarding restricted, so that they will not interfere with each other. The default multicast address used in 
Gentran Integration Suite release 4.2 is "239.255.166.17". This address is configurable, with a port range of 
10 ports, starting with the multicast base port for the instance.

All nodes participating in the same cluster must be installed on the same multicast base port (the 
multicastBasePort property in the noapp.properties file).  This is usually computed from the system base 
(non-multicast) port, but can be configured separately in the noapp.properties file, to allow different nodes 
in a cluster to be installed at different (non-multicast) port ranges.  Also, all the nodes in the cluster should 
be installed in the same subnet.

Configuring Shared File System as Document Storage
In a Gentran Integration Suite cluster, the default document storage is database, so that all of the nodes in 
the cluster have line of sight to the documents to access and process the documents. However, using the 
database for document storage has performance implications over using the file system for document 
storage. 

To use the file system as document storage in cluster, the file system needs to be a shared/mounted/clustered 
file system with all nodes having line of sight to the file system. 

For each Gentran Integration Suite node, follow this procedure to configure a shared file system in a Gentran 
Integration Suite cluster:

1. Go to install/properties dir.
2. Change the document_dir property in jdbc.properties to point to the shared file system directory 

configured to store the documents.
3. Restart Gentran Integration Suite (all nodes).

This configures a shared file system directory as document storage.

Installing the Current Maintenance Patch in UNIX or Linux
Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each patch 
contains the fixes from previous patches, you only need to install the most recent patch. 

To help you determine which patch to use, the files are named using the following naming convention: 

si_engine_<build number>.jar

For example, a file named si_engine_1976.jar is the patch for build 1976 for Gentran Integration Suite 4.1, 
which is labeled Gentran Integration Suite 4.2 in the user interface.
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Information about a patch is located in a text file with a similar name. The naming convention for text files 
containing information about a particular patch is:

si_engine_<build number>_patch_info.txt

For example, a file named si_engine_1976_patch_info.txt contains information about build 1976 for 
Gentran Integration Suite 4.1, which is labeled Gentran Integration Suite 4.2 in the user interface.

Both the jar and the txt files are available on the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. You should periodically check the web site to verify 
that you have the most recent patch.

Note: The patch installation may use one or more patch property override files. These files will be named 
propertyFile_patch.properties. Do not alter these files. 
Additionally, property changes made directly in .properties or .properties.in files may be overwritten 
during the patch installation. Properties overridden using the customer_overrides.properties file are 
not affected.

To install the latest patch for Gentran Integration Suite in a UNIX or Linux environment, follow the steps 
below.

1. Go to the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx.

2. Download the most recent patch file for your version of Gentran Integration Suite and record the 
absolute path to the downloaded file. If you use FTP, use Binary mode. Do not rename the file.

3. If you are using a database other than MySQL, verify that the database server is up and ready to accept 
connections.

4. Stop Gentran Integration Suite.
5. Perform a full backup of the Gentran Integration Suite installation directory, including all 

subdirectories. Also back up your database.
6. If you edited any property files, ensure that the associated .properties.in files have the most current 

changes. Property files will be overwritten with the contents of the associated .properties.in files 
during the patch installation.

7. Is the database password encrypted? If Yes, decrypt the password. See Decrypting a Password 
(UNIX).

8. Change to the directory where Gentran Integration Suite is installed and install the patch using the 
following commands:
a. cd install_dir/bin and press Enter.
b. Run the following command to install the patch:

InstallService.sh 
<path>/si_<version>_sp_0_patch_<number>_<app_server>.jar

where:
<path> = Fully qualified path to maintenance patch file
<version> = Gentran Integration Suite Version
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<number> = Patch number
<app_server> = Application Server
Example: InstallService.sh /opt/patch/si_22_sp_0_patch_1_jboss.jar

Information about the patch installation is automatically logged to install_dir/logs/InstallService.log.
If the patch attempts to modify the database schema and the modification fails, you will receive an 
error message about the failure. The message will provide the error message code from the database 
and the SQL command that failed. The failure information is also logged to the system.log file and to 
the patch.log file. If you cannot determine whether the failure can be safely ignored, contact Sterling 
Commerce Customer Support for assistance. Choose one of the following options when prompted:

Continue – If you determine that the failure can be safely ignored, continue with the patch 
installation.

Stop – Stop the patch installation. You should always contact Sterling Commerce Customer 
Support for assistance before choosing this option.

Retry – Choose this option to retry the failed command. 

9. If you decrypted the database password, re-encrypt the password. For information, see Encrypting 
Database Passwords on page 35.

10. Restart Gentran Integration Suite.

If you are using a perimeter server in a DMZ, see Installing Patches in a Perimeter Server Environment on 
page 31.

Installing Patches in a Perimeter Server Environment
Perimeter servers in a DMZ are not automatically updated by a service pack or patch. You must reinstall the 
perimeter server using the new perimeter server installation file supplied with the service pack or patch. You 
can determine the proper answers to most of the questions asked during the perimeter server installation by 
reading a script in your previous installation directory. The name of the script is startupPs.sh.

To Update a DMZ Perimeter Server in a UNIX or Linux environment:
1. Locate the ps42service_pack-patch.jar file in the install_dir/packages directory. For maintenance 

patches, obtain the file from the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. These patch files will have have a longer name 
that identifies the associated maintenance patch. For example, ps42-1976.jar.

2. Copy the file to the home directory or base directory on the DMZ server.
3. Stop the perimeter server using the stopPs.sh command.
4. To begin the installation, type /absolutepath/bin/java -jar filename.jar.

absolutepath is the directory name where the Java version is installed.
The program verifies the operating system and required patch level and the location and version of the 
JDK.

5. Type the full path to the installation directory. 
6. The program verifies the amount of available disk space.
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7. Type the TCP/IP address or DNS name for the internal interface, or press Enter to use a wildcard 
address.

8. Verify the TCP/IP address or DNS name for the internal interface.
9. Type the TCP/IP address or DNS name for the external interface, or press Enter to use a wildcard 

address.
10. Verify the TCP/IP address or DNS name for the external interface.
11. Type the port that the perimeter server will listen on for the connection from the integration server. The 

port number must be higher than 1024.
12. Verify that the port you entered in the previous step is correct. 
13. Type the maximum amount of heap space the JVM should allocate in MB. The default value is 

512MB, and valid values range from 64 to 2048MB.
14. Verify the maximum amount of heap space the JVM should allocate.
15. The message, Installation of Perimeter Service is finished, displays when the perimeter server is 

installed.
16. Change to the installation directory.
17. Type startupPs.sh to start the perimeter server.

Installing Patches in a Clustered Environment
All nodes in a cluster must be patched to the same level. You should stop all nodes in the cluster before 
installing a patch and then install the patch on each node.

It is possible, in some cases, to apply patches to nodes while others are still processing. However, a patch 
containing any of the following requires the entire cluster to be down:

✦ Critical cluster functionality
✦ Engine-related changes
✦ Changes to the database
Attempting to apply patches while part of the cluster is running should only be done with the advice of 
Sterling Commerce Customer Support.

Updating the Database (dbupdate) with the startCluster Command
The startCluster.sh nodeNumber command on node 1 will automatically update the database, unless you 
use the command startCluster.sh 1 false. The startCluster.sh nodeNumber command on all other nodes 
will not update the database.

When you configure the Gentran Integration Suite cluster for the first time, you should run the 
startCluster.sh command with the database update value set to true (startCluster.sh 1 true), or just 
startCluster.sh 1, since on node 1, dbupdate defaults to true. This makes all cluster-related configurations 
take effect. The database update will synchronize the scheduled jobs between the nodes by assigning them 
all to node 1. 

The startCluster.sh command with the database update value turned off (startCluster.sh 1 false) prevents 
any configuration changes from affecting the system, especially after you install patches or hot-fixes.
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For current database updates, the following services are tied to node 1:

✦ Schedule
✦ FileSystem
✦ CmdLine
✦ CDServerAdapter
✦ CDAdapter
✦ CDRequesterAdapter
✦ CEUServerAdapter
✦ HttpServerAdapter
✦ B2B_HTTP_COMMUNICATIONS_ADAPTER
✦ HTTP_COMMUNICATIONS_ADAPTER
✦ HTTPClientAdapter
✦ FTPClientAdapter
✦ FtpServerAdapter
✦ SFTPClientAdapter
The following services have storage set to the database:

✦ HttpServerAdapter
✦ CEUServerExtractServiceType
✦ CDSERVER_ADAPTER
The default storage of all workflows is set to the database.

Applying a Patch in a Clustered Environment Stopping the Whole Cluster
For a critical patch where the whole cluster needs to be down, use the following process: 

1. Stop the whole cluster.
2. Install the patch on each node by running the following command from the install_dir/bin directory:

./InstallService.sh <si_engine_####.jar>
Apply the patch to node1 first, and then to the subsequent nodes: node2, node3, etc. For node1, 
REINIT_DB=true in sandbox.cfg. For subsequent nodes, REINIT_DB=false, which prevents database 
updates from repeating on each node's patch installation. This is automatically set during the patch 
installation for all nodes except node1 if the installation is done using the nodbinit option. 

3. Start each node by running startCluster.sh nodeNumber.

Applying a Patch in a Clustered Environment Stopping One Node at a Time
For a patch where you can stop the cluster one node at a time, use the following process:

Note: Apply the patch to node1 first, and then to the subsequent nodes: node2, node3, etc. 
1. Shut down the node using the install_dir/bin/hardstop.sh command.

Wait until the perimeter server of the node is completely down before installing the patch.
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2. Install the patch by running the following command from the install_dir/bin directory:
./InstallService.sh <si_version number_sp_sp number_patch_patch number_application 
server.jar>
For node1, REINIT_DB=true in sandbox.cfg. For subsequent nodes, REINIT_DB=false, which 
prevents database updates from repeating on each node's patch installation. This is automatically set 
during the patch installation for all nodes except node1 if the installation is done using the nodbinit 
option. 

3. Start the node. Run ./startCluster.sh nodeNumber.
4. Open install_dir/properties/sandbox.cfg in a text editor. Perform the following steps:

a. If REINIT_DB=true, back up the sandbox.cfg file and change REINIT to false.
b. Save and close the sandbox.cfg file.
This prevents database updates from being repeated for each node.

5. Repeat steps 1 through 4 for each subsequent node.

Installing a Hot-Fix in UNIX or Linux
After you install Gentran Integration Suite, you may need to install a hot-fix. A hot-fix is one or more fixes 
applied to a specific existing patch.

Before Installing a Hot-Fix
Before you can install a hot-fix developed for your company, you must have completed the following:

✦ Received the file name of the caseid.jar to install from Sterling Commerce Customer Support
✦ Created a full backup of Gentran Integration Suite
✦ Created a full backup of your database

Installing a Hot-Fix
To install a hot-fix on a UNIX or Linux system:

1. Log in to the computer that you are installing the hot-fix on.
2. Is the database password encrypted? If Yes, decrypt the password. See Decrypting a Password 

(UNIX).
Apply the hot-fix to node 1 first, and then to the subsequent nodes: node 2, node 3, etc. For node 1, 
REINIT_DB is true in install_dir/install/properties/sandbox.cfg. For subsequent nodes, REINIT_DB 
is false, which prevents database updates from repeating on each node's hot-fix installation.

3. At the command line, type ftp theworld.stercomm.com.
4. Type your user name and password. If you do not know your user name and password, contact Sterling 

Commerce Customer Support.
5. Type bin and press Enter to select Binary as your transfer mode.
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6. At the FTP prompt, type get ccaseid.jar, where caseid is the ID number you received from Customer 
Support.
Note: You can put the file to any directory for which you have write permission.

7. Shut down Gentran Integration Suite.
8. Change to the install_dir/bin directory.
9. Type ./InstallService.sh absolutepath/ccaseid.jar to install the hot-fix.

Caution: You may need to complete this step twice depending on the patch. Read the output from the 
InstallService.sh script carefully to see if you need to complete this step twice.

10. If you decrypted the database password in step 2, re-encrypt the password. For information, see 
Encrypting Database Passwords on page 35.

11. Restart Gentran Integration Suite. For more information, see Starting Gentran Integration Suite in 
UNIX or Linux on page 38.

12. In the install_dir/bin directory, run dump_info.sh to verify that the hot-fix was successfully installed.

Encrypting Database Passwords
Gentran Integration Suite uses a password to connect to the database being used. Currently, Gentran 
Integration Suite stores the password as clear text in a property file on the system. If the security policies at 
your company require you to encrypt these passwords, you can do so after you install Gentran Integration 
Suite. Encrypting these passwords is optional. 

To encrypt the database password used by Gentran Integration Suite in UNIX, follow these steps:

1. Stop Gentran Integration Suite.
2. Run /install_dir/bin/enccfgs.sh. 
3. Run /install_dir/bin/setupfiles.sh.
4. Run /install_dir/bin/deployer.sh.
5. Run run.sh to start Gentran Integration Suite. 
6. Enter your passphrase.

Setting Up Perimeter Servers with Gentran Integration Suite
Using a perimeter server with Gentran Integration Suite is optional. 

A perimeter server is a software tool for communications management that is installed in a DMZ. The 
perimeter server manages the communications flow between outer layers of your network and Gentran 
Integration Suite’s TCP-based transport adapters. A perimeter server can solve problems with network 
congestion, security, and scalability, especially in high-volume, Internet-gateway environments. A 
perimeter server requires a corresponding perimeter client. 

The Gentran Integration Suite installation program installs a perimeter client and a local mode server. The 
local mode server is useful for testing purposes or in environments that do not require a DMZ solution. 
However, if you require high-volume, secure connections, you must install a perimeter server in a DMZ.
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When you install a perimeter server, use these guidelines:

✦ Licensing for a perimeter server is determined by the licensing restrictions on the corresponding 
transport adapters in Gentran Integration Suite: FTP Server, FTP Client, HTTP Server, HTTP Client, 
SFTP Server, SFTP Client, Connect:Direct Server, and Connect:Direct Requester.

✦ Each perimeter server is limited to two TCP/IP addresses–internal interface and external interface. 
Internal interface is the TCP/IP address that the perimeter server uses to communicate with Gentran 
Integration Suite. External interface is the TCP/IP address that the perimeter server uses to 
communicate with trading partners. 
To use additional TCP/IP addresses, install additional perimeter servers.

✦ You may have multiple perimeter servers installed on the same computer interacting with one instance 
of Gentran Integration Suite. To install a perimeter server on a computer with an existing instance, 
install the new perimeter server in a different installation directory.

✦ The combination of internal TCP/IP address and port must be unique for all perimeter servers installed 
on one computer.

If a perimeter server is installed using the wildcard address, then all ports must be unique.

If a perimeter server is installed using the wildcard address, then its port is not available for use by 
adapters that use the server or any other perimeter server on that computer. 

The internal and external interface may use the same TCP/IP address. However, the port used by 
the perimeter server is not available to the adapters that use the server.

Installing a Perimeter Server in a UNIX or Linux Environment
To install a perimeter server in a UNIX or Linux environment: 

1. Insert the Gentran Integration Suite installation CD in the appropriate drive.
2. Copy the ps42service_pack-patch.jar installation files from the installation CD to your home directory 

or base directory. If you are using FTP to copy the file, make sure your session is set to binary mode.
3. To begin the installation, type the absolute path to the following jar file:

/absolutepath/bin/java -jar ps42service_pack-patch.jar 
The program verifies the operating system and required patch level and the location and version of the 
JDK.

4. Enter the name of the installation directory.
The program verifies the amount of available disk space.

5. At the prompt Is this server in a less secure network than the integration server?, do one of the 
following:

If you are installing the perimeter server in a less secure location than the integration server (for 
example, in a DMZ when Gentran Integration Suite is installed in the secure network zone), type y 
and press Enter.

If you are installing the perimeter server in a more secure location than the integration server (for 
example, in a secure network zone when Gentran Integration Suite is installed in a second tier 
DMZ), type n and press Enter.
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6. Enter the TCP/IP address or DNS name for the internal interface, or press Enter to use a wildcard 
address.

7. Verify the TCP/IP address or DNS name for the internal interface.
8. Enter the TCP/IP address or DNS name for the external interface, or press Enter to use a wildcard 

address.
9. Verify the TCP/IP address or DNS name for the external interface.
10. Take one of the following actions, based on the entry at Step 5:

If you typed y at Step 5, enter the port that the perimeter server will use to listen for the connection 
from Gentran Integration Suite. The port number cannot be lower than 1024.

If you typed n at Step 5, enter and verify both the IP address (or host name) of the Gentran 
Integration Suite instance to which this perimeter server will connect, and the network port that 
this Gentran Integration Suite instance will be listening on.

11. Verify that the port you entered in the previous step is correct.
12. Enter the maximum amount of heap space, in MB, the JVM should allocate or press Enter to use the 

default size of 512MB. Valid values range from 64 to 2048MB.
13. Verify the heap size.

When the perimeter server is installed, the following message displays:
Installation of Perimeter Service is finished

14. Change to the installation directory.
15. Enter startupPs.sh to start the perimeter server.

Starting and Stopping Perimeter Servers in UNIX or Linux
To start a perimeter server in UNIX or Linux:

1. Change the directory to install_dir/bin.
2. Enter startupPs.sh.

To stop a perimeter server in UNIX or Linux:

1. Change the directory to install_dir/bin.
2. Enter stopPs.sh.

Postinstallation in a UNIX or Linux Environment
After installing Gentran Integration Suite, you should complete the following tasks:

✦ Starting Gentran Integration Suite in UNIX or Linux on page 38
✦ Accessing Gentran Integration Suite on page 38
✦ Validating the Installation on page 40
✦ Downloading Gentran Integration Suite Tools on page 40
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✦ Performing Initial Administrative Setups in Gentran Integration Suite on page 40
✦ Stopping Gentran Integration Suite on page 40
✦ Starting or Stopping the Cluster Environment on page 41
✦ Cluster Environment Verification on page 41

Starting Gentran Integration Suite in UNIX or Linux
To start Gentran Integration Suite in a UNIX or Linux environment, follow these steps:

1. Change the directory to install_dir/bin.
2. Enter run.sh.
3. Enter the passphrase that you supplied during installation. If you receive a message about an invalid or 

corrupt license file, see Troubleshooting: UNIX or Linux Environment on page 43.
When startup is complete, a message like the following is displayed:

Open your Web browser to http://host:port/dashboard, where host:port is the IP address and port 
number where Gentran Integration Suite resides on your system.

Make a note of the URL address so you can access Gentran Integration Suite later.
The system returns you to a UNIX prompt.

Accessing Gentran Integration Suite
To log in to Gentran Integration Suite the first time, follow these steps:

1. Be sure that Gentran Integration Suite is started and running.
2. Open a browser window and type the address displayed at the end of startup.
3. The login page for Gentran Integration Suite displays. 
4. Type the default user ID and password. The default login is at an administrative level. One of your first 

tasks as an administrator is to change the administrative password and to register other users with other 
levels of permission.

Technical Note: Changes to Network Interface Bindings

System Default login

Gentran Integration Suite User ID: admin
Password: password

AS2 Edition User ID: as2_user
Password: password

UCCnet Edition User ID: uccnet_user
Password: password
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To increase the security of the Administrator Console user interface, Gentran Integration Suite Version 4.2 
binds only to specific network interfaces. By default, previous versions had been bound to all network 
interfaces. After installing, if the URL for Gentran Integration Suite returns Page cannot be displayed, you 
can adjust property settings to correct the problem.

1. On the server where Gentran Integration Suite resides, edit the noapp.properties.in file.
a. Locate the admin_host parameter. The default settings are as follows:

hostname1 is the name of primary network interface, the one given highest priority by Gentran 
Integration Suite.
localhost is the name of the network interface on the server where Gentran Integration Suite 
resides.
Default entries

admin_host.1    = hostname1

admin_host.2    = localhost

b. Correct the parameters as necessary.
If no interface is being displayed, edit hostname1 so that it correctly identifies the primary network 
interface that accesses Gentran Integration Suite.

If an additional network interface needs to access Gentran Integration Suite, add an additional 
admin_host entry, as shown below. 
Edited entries

admin_host.1    = hostname1

admin_host.2    = localhost

admin_host.3    = hostname2

2. Stop Gentran Integration Suite.
3. Run the setupfiles.sh utility located in the install_dir/bin directory.
4. Restart Gentran Integration Suite.

For the Dashboard user interface, Gentran Integration Suite Version 4.2 provides unrestricted binding to 
network interfaces through the perimeter server. To restrict access to the Dashboard user interface, you can 
adjust property settings so that only one network interface accesses Gentran Integration Suite. 

1. On the server where Gentran Integration Suite resides, edit the perimeter.properties.in file.
a. Locate the localmode.interface parameter. The default setting is unrestricted, as shown below. 

Unrestricted Setting (Default)

localmode.interface=*

b. To restrict access to the Dashboard, type the network interface that you want Gentran Integration 
Suite to support.
Restricted Setting

localmode.interface=hostname1

2. Stop Gentran Integration Suite.
3. Run the setupfiles.sh utility located in the install_dir/bin directory.
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4. Restart Gentran Integration Suite.

Validating the Installation
After you install, start, and log in to Gentran Integration Suite the first time, you can validate the installation 
by testing a sample business process. Follow these steps:

1. Open a browser window and type the address for Gentran Integration Suite. This address was 
displayed at the end of startup.

2. Enter your user login and password. 
3. From the Administration menu, select Business Processes > Manager.
4. In the Process Name field, type Validation_Sample_BPML and click Go!
5. Click execution manager.
6. Click execute.
7. Click Go! The Status: Success message displays in the upper left side of the page.

Downloading Gentran Integration Suite Tools
Gentran Integration Suite includes four tools that run on a desktop or personal computer. After you install, 
start, and access Gentran Integration Suite, you can install the following tools by downloading them from 
within Gentran Integration Suite: 

✦ Map Editor and associated EDI and CII standards
✦ Graphical Process Modeler
✦ Web Template Designer
✦ Service Developer’s Kit
Conflicting IP addresses can cause problems when you download a desktop tool. See Troubleshooting: 
UNIX or Linux Environment on page 43.

Performing Initial Administrative Setups in Gentran Integration Suite
If you are installing Gentran Integration Suite for the first time, you need to perform some initial 
administrative setups before users can use the application. For example, the system administrator for 
Gentran Integration Suite must register users, grant permissions, and run several performance reports so that 
benchmarks are established for tuning the system in the future. 

Stopping Gentran Integration Suite
To stop Gentran Integration Suite in a UNIX or Linux environment, you can either run a softstop or a 
hardstop script.

A softstop halts Gentran Integration Suite after all the business processes finish running. To run a softstop, 
choose one of the following procedures:
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✦ Open your browser and access Gentran Integration Suite. From the Administration menu, select 
Operations > System > Troubleshooter. Click Stop the System.

✦ From the UNIX command line, change directory to install_dir/bin. Enter ./softstop.sh. Then type your 
passphrase. 

Caution: Running softstop.sh command in a multiple node (clustered) environment will suspend all 
scheduled business processes.  It is recommended to run the hardstop.sh command when 
stopping individual nodes of a cluster.

A hard stop halts Gentran Integration Suite without waiting for business processes to finish. To run a hard 
stop, use the following procedure:

1. From the UNIX command line, change directory to install_dir/bin.
2. Enter hardstop.sh.
Caution: Running a hard stop could result in loss of data in unfinished processes.

Starting or Stopping the Cluster Environment
Note: To run Gentran Integration Suite cluster, you need to get a valid Gentran Integration Suite license 

for multiple IP address of all the nodes where Gentran Integration Suite will be installed and 
configured as a cluster.

You can start the Gentran Integration Suite cluster environment by running the following command on each 
node, starting with node1 (It is recommended to start node1 first.):

$ run.sh

If you are restarting the entire cluster, please use run.sh with an additional parameter "restart" on node1.

You can stop a Gentran Integration Suite cluster by using one of the following options:

✦ hardstop.sh or hardstop.cmd from each node. This does a kill -9
✦ softstop.sh or softstop.cmd from each node. This does a regular cleanup and shutdown of all 

components.
Caution: Running softstop.sh command in a multiple node (clustered) environment will suspend all 

scheduled business processes.  It is recommended to run the hardstop.sh command when 
stopping individual nodes of a cluster.

✦ Shut down the whole cluster by selecting Operations > System > Troubleshooter, and then clicking 
the Stop the System link.

✦ Shut down specific nodes by selecting Operations > System > Troubleshooter, and then clicking the 
shutdown link.

Cluster Environment Verification
This section explains the verification process for the Gentran Integration Suite cluster environment.

✦ Verify the following properties:
The property CLUSTER=true is included in sandbox.cfg 
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The cluster property in centralops.properties and noapp.properties is true and the clustered_env 
property in ui.properties is set to true

✦ Using the System Troubleshooter, you can verify the cluster environment by viewing the following 
information for each node:
a. Queue information 
b. JNDI Tree for each node
c. Host, state, status, adapters, and memory usage information
d. Perimeter Server
e. Shows adapter status for each node with a dropdown box listing all nodes in cluster  

✦ Operations/Troubleshooter Admin UI page displays all the cluster nodes, ops URL, node URL, the 
status of the node and which node holds the token.

✦ The Operations/System/Logs UI information is useful for tracking the errors and exceptions in the 
system. In a clustered environment, the logs are provided for each node. A dropdown lists all the nodes 
and by selecting the node the logs corresponding to the nodes is displayed. You can see each log item 
in this page for each node after all nodes start.

✦ The Activity Monitor UI provides the status of running business process and scheduled services. Using 
this feature, you can monitor all service activities including the node on which each activity is 
executing. 

✦ The Operations/System/ Troubleshooter Admin UI, by selecting the Threads for a node, the pop-up 
window displays current threads that running on specific node.

Uninstalling Gentran Integration Suite from a UNIX or Linux 
Environment
When you uninstall Gentran Integration Suite, the following components are affected:

✦ The Gentran Integration Suite application is automatically removed from the server.
✦ The MySQL database is automatically removed from the server (if you are using MYSQL).
Additionally, you may perform the following tasks:

✦ Manually remove Attunity Data Connect
✦ Manually remove the JDK that was installed
✦ Manually remove Java WebStart and any desktop tools that were downloaded
✦ Free any database space in Oracle, MS SQL, or DB2 databases
To uninstall Gentran Integration Suite from a UNIX or Linux environment, follow these steps:

1. Stop Gentran Integration Suite and wait for shutdown to complete. If you begin removing files before 
all business processes and Gentran Integration Suite are stopped, you may be unable to remove 
Gentran Integration Suite successfully. 

2. Back up the file system and database. This step is optional; however, by backing up the file system and 
database, you are ensured that Gentran Integration Suite is completely recoverable.
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3. Enter the following command:
rm -rf install_dir 

This step deletes MySQL, if you are using this bundled component.
4. If you use an Oracle, MS SQL, or DB2 database, these remain intact even after you remove Gentran 

Integration Suite from the server. If you no longer want to reference the data, contact your database 
administrator about removing unwanted tables and recovering the database space where Gentran 
Integration Suite used to reside.

5. Manually remove Attunity Data Connect at the server level and on PCs. For more information, refer to 
product information provided with Attunity Data Connect software. 

6. Manually remove the JDK from PCs: 
a. Select Start > Settings > Control Panel.
b. Select Add/Remove Programs.
c. Select Java 2 Runtime Environment Standard Edition v<version number> and click Remove.
d. Select Java 2 SDK Standard Edition v<version number> and click Remove.
e. Close Add/Remove Programs.
f. Close the Control Panel.

7. After you remove Gentran Integration Suite from the server, you can remove Java WebStart and any 
tools that were downloaded to the desktop:

Map Editor and associated EDI and CII standards

Graphical Process Modeler

Web Template Designer

Service Developer’s Kit

Troubleshooting: UNIX or Linux Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems 
during installation.

Explanation
Installation creates a log file.
Resolution
Examine the log file generated during installation:

install_dir/InstallSI.log
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Installing When you entered an absolute path 
during installation, a message 
indicated that the command was not 
found.

Explanation
You entered an incorrect path. Check your typing or check the 
information.
Resolution
Enter the correct path. 

Installing During installation, you entered the 
absolute path to the license file. 
However, a message indicates that 
the license file cannot be found.

Explanation
You either did not obtain the license file, the license file is 
corrupt, or you downloaded the license file to a PC but have 
not moved it to the server. 
Resolution
If you need to obtain the license file, see Obtaining a License 
File on page 19. If the license file resides on a PC, save the 
license file to the server.

Installing a 
desktop 
tool or 
resource

Cannot download any of the following:

Map Editor

Graphical Process Modeler

Web Template Designer

Service Developer’s Kit

Explanation
When you install Gentran Integration Suite, system files are 
created that contain an internal IP address. If you install 
Gentran Integration Suite behind a firewall, and your firewall is 
configured to accept an external IP address from a client 
computer, you may not be able to download the desktop tools 
and resources. The firewall will reject the internal IP address 
from a client residing outside of the firewall. 
Resolution
Modify the system files that contain the invalid IP address. 
Follow these steps:
1 Navigate to the install_dir/bin directory.
2 Enter the following command followed by the external 

IP address:
./patchJNLP.sh external_IP address

3 Stop Gentran Integration Suite. 
4 Restart Gentran Integration Suite. 

Accessing Attempts to access the URL for 
Gentran Integration Suite display the 
message: Page cannot be displayed

See Accessing Gentran Integration Suite on page 38.

Situation Message or Symptom Explanation/Resolution
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Chapter 2

Installing in a Windows Environment

This section includes the following sections:

✦ Preinstallation Setup Checklist for a Windows Environment on page 45
✦ Installing in a Windows Environment on page 54
✦ Postinstallation in a Windows Environment on page 70
✦ Uninstalling Gentran Integration Suite from a Windows Environment on page 75
✦ Troubleshooting: Windows Environment on page 77

Preinstallation Setup Checklist for a Windows Environment
The following topics will assist you with preinstallation tasks when planning to install Gentran Integration 
Suite in a Windows environment:

✦ Key Terms on page 45
✦ Checklist for Windows Preinstallation on page 46
✦ Checking System Requirements on page 48
✦ Installing the Java 2 Software Development Kit on page 48
✦ Downloading the JCE Distribution File on page 48
✦ Determining Port Numbers on page 49
✦ Creating and Configuring the Database Server on page 49
✦ Obtaining a License File on page 53

Key Terms
The following terms and definitions will assist you in understanding the concepts of installing Gentran 
Integration Suite in a Windows environment discussed in this document:
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✦ Java 2 Software Development Kit (JDK) – Software development kit (SDK) for producing Java 
programs. Produced by Sun Microsystems, Inc., the JDK includes JavaBeans component architecture 
and support for JDBC.
Note: The Gentran Integration Suite System Requirements include information about upgrading your 
JDK for the changes enacted in 2007 for Daylight Savings Time.

✦ Gentran Integration Suite License File – Contains a license that is associated with your specific 
operating system and the IP address of your system. The license provides access, for a year, to the 
Gentran Integration Suite packages your company selected. 

✦ The Java Cryptography Extension (JCE) is a set of Java packages from Sun Microsystems, Inc. that 
provides a framework and implementations for encryption, key generation and key agreement, and 
Message Authentication Code (MAC) algorithms. 

✦ Rollback Segment – Enables you to undo (rollback) DML (data manipulation language) transactions 
that were made against a database. In Oracle version 9i or later, you also can perform this task with 
Undo tablespaces.

Checklist for Windows Preinstallation
The preinstallation checklist for the Windows environment identifies the prerequisite tasks you must 
complete before installing Gentran Integration Suite.

Note: When creating a name, such as an account name, permissions name, profile name, or database name, 
follow these conventions:

Use any valid alphanumeric characters and -, :, $, &, or _.

Do not use spaces or apostrophes.

You may want to make a copy of the following checklist and use it to record the information you collect for 
installing Gentran Integration Suite:

Step Description Your Notes

1 Verify that your system meets the hardware and software 
requirements specified for this release. See Checking 
System Requirements on page 48.

2 Verify that your system has the patches required by 
Java™ for the Windows environment. See the vendor’s 
Java Web site for more information.

3 For systems with multiple IP addresses, verify that the IP 
address on which Gentran Integration Suite resides is 
accessible by any client computer that is running a 
browser interface.
Caution: If you do not verify the IP addresses, your 
system may not operate properly after installing Gentran 
Integration Suite.

4 Verify that all client computers are using Microsoft 
Internet Explorer 5.x or later.
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5 If you are using a non-English environment, confirm that 
you are using the appropriate character set.

6 Determine and record information about the JDK. See 
Installing the Java 2 Software Development Kit on page 
48.

Version of the JDK

Absolute path to the JDK files and patches. The path 
name can not include spaces.

7 Obtain the JCE distribution file and record the absolute 
path to the zipped file. See Downloading the JCE 
Distribution File on page 48.

8 Determine and record the initial port number to be used 
by Gentran Integration Suite. See Determining Port 
Numbers on page 49.

9 If you are using a SQL Server database or an Oracle 
database, determine and record information about your 
database server. Be aware that this information is case 
sensitive. See Creating and Configuring the Database 
Server on page 49.

Database vendor

Database user name and associated password

Database (catalog) name

Database host name

Database host port number

Absolute path and file name for the JDBC driver

Version of the JDBC driver

10 Determine and record information to set up default 
system alerts from Gentran Integration Suite:

The Administrative e-mail address to which system 
alert messages are sent. 

The SMTP Server IP address used for sending alert 
messages.

11 Determine and record the directory in which you plan to 
install Gentran Integration Suite.

The installation directory must not exist because the 
installation process creates it.

The installation directory must have adequate free 
disk space.

The name of the directory can not include spaces and 
must be less than 30 characters long.

Step Description Your Notes
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Checking System Requirements
Before you begin, verify that your system meets the hardware and software requirements specified for this 
release. The hardware requirements listed are the minimum required to run Gentran Integration Suite. Your 
system requirements will exceed these if you are running other applications on the same machine as Gentran 
Integration Suite. For current information, see the System Requirements posted on the Gentran Integration 
Suite Documentation Library:

http://www.sterlingcommerce.com/Documentation/GIS42/homepage.htm

Note: Version 4.2 of Gentran Integration Suite does not require an application server for installation or at 
run-time. However, Gentran Integration Suite supports integration with JBoss™ and WebLogic®. 
You can also integrate with WebSphere®, JBoss, or WebLogic after installing version 4.2 by using 
the Gentran Integration Suite EJB Adapter.

Installing the Java 2 Software Development Kit
You must install the Java 2 Software Development Kit (JDK) and the patches specific to your system. To 
determine which JDK version and patches you need, see the Gentran Integration Suite System Requirements. 
After you install the JDK, record the absolute path to its location on your system. You must supply the 
absolute path when you install Gentran Integration Suite.

Caution: In Windows, the directory name where the JDK resides cannot include a space.

Note: The System Requirements include information about upgrading your JDK for the changes enacted in 
2007 for Daylight Savings Time.

Downloading the JCE Distribution File
The Java Cryptography Extension (JCE) is a set of Java packages from Sun Microsystems, Inc. that provides 
a framework and implementations for encryption, key generation and key agreement, and Message 
Authentication Code (MAC) algorithms. 

To obtain this file:

1. Open your browser and navigate to http://java.sun.com/products/jce/index-14.html.
2. At the bottom of the page, locate the section Downloading the "Unlimited Strength" Jurisdiction 

Policy Files and click Download JCE Unlimited Strength Jurisdiction Policy Files.

12 Determine and record the passphrase you want to use 
for the Gentran Integration Suite system. 
During installation, you must enter the passphrase twice.

13 Obtain the license file and record the absolute path and 
file name to the license file. Be sure that the path name 
and the file name do not contain any spaces. See 
Obtaining a License File on page 53.

Step Description Your Notes
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3. Download the zipped JCE 1.4.2 distribution file to your system. Once the file resides on your system, 
note the exact directory and file name for this zipped file.

Determining Port Numbers
During installation, you are prompted to specify the initial port number for Gentran Integration Suite. For 
other ports, you can accept the default port number suggested by the installation program, or you can specify 
a different port number. To specify a port number, follow these guidelines:

✦ Gentran Integration Suite requires a range of 100 consecutive open ports between 1025 and 65535. 
✦ The initial port number represents the beginning port number in the range. 
✦ The port range starts with the initial port number and ends with the number that equals the initial port 

number plus 100. All ports in this range must be available for Gentran Integration Suite. For example, 
if you specify 10100, then you need to make sure that 10100 through 10199 are not used by any other 
applications on your system. 

Creating and Configuring the Database Server
You must install, create, and configure a database so that each Gentran Integration Suite instance has a 
dedicated schema and login for the database.

Caution: If you are reinstalling Gentran Integration Suite, be aware that data in your existing database will 
be deleted. To prevent this, either back up the existing database or save it under a different name.

After creating and configuring your database, recycle the database. Then stop and restart Gentran 
Integration Suite to apply the changes. 

In a Windows environment, Gentran Integration Suite supports the following databases. 

✦ MySQL™  (See Using a MySQL Database Server on page 49)
✦ Microsoft SQL Server™ Enterprise (See Using a Microsoft SQL Server Database Server on page 50)
✦ Oracle® 9i or 10g (See Using an Oracle Database Server on page 51)
See System Requirements for supported version information.

Using a MySQL Database Server
You can use a MySQL database server with Gentran Integration Suite. See System Requirements for version 
information. This database is bundled with Gentran Integration Suite. Choosing this database during the 
installation procedure creates and configures it for you. MySQL is installed locally on the same server as 
Gentran Integration Suite and cannot be installed on a separate server.

If you have a pre-3.1 version of Gentran Integration Suite installed, only one instance of Gentran Integration 
Suite that uses MySQL as the bundled database can be installed on a particular server. For example, you 
cannot install Gentran Integration Suite 4.2 and Gentran Integration Suite 3.0 on the same server.
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Using a Microsoft SQL Server Database Server

You can use a Microsoft SQL Server database with Gentran Integration Suite. See System Requirements for 
supported version information. To use an MS SQL Server database, follow this process:

✦ Create the database. Refer to your vendor’s documentation for information about creating the 
database, including creating a schema repository, login, and tablespace. Be sure to install the correct 
version and patch.

✦ Configure the database by completing the following tasks:
Setting Database Parameters in SQL Server on page 50

Granting Permissions in SQL Server on page 50

Installing the JDBC Driver in SQL Server on page 50

Setting Database Parameters in SQL Server

Gentran Integration Suite requires the following parameter settings in your SQL Server database:

Granting Permissions in SQL Server

In SQL Server, you must grant DBO (Database Owner) permission to the Gentran Integration Suite user.

Installing the JDBC Driver in SQL Server

Gentran Integration Suite requires the correct Microsoft SQL Server driver. See System Requirements for 
supported version information. The supported version of the JDBC driver builds the correct Gentran 
Integration Suite directory structure.

Go to http://www.microsoft.com/downloads to download this driver, any appropriate patches, and the 
following jar files. Be sure to place all the jar files in the same directory.

✦ msbase.jar
✦ mssqlserver.jar
✦ msutil.jar files
After you obtain the JDBC driver file and jar files, record the absolute path to their location on your system. 
You must supply this absolute path when you install Gentran Integration Suite.

Parameter Value

Collation Setting SQL_Latin1_General_CP850_BIN

Sort order Binary

Security authentication SQL Server and Windows

Torn Page Detection Off

Parallelism Use one processor (do not use all available 
processors)
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Using an Oracle Database Server
You can use an Oracle 9i or 10g database with Gentran Integration Suite. See System Requirements for 
supported version information. Gentran Integration Suite supports Oracle 10g in a single node database 
environment.

Note: Oracle 10g RAC is not supported by Gentran Integration Suite 4.2.

To use an Oracle 9i or 10g database, follow this process:

✦ Create the database. Refer to your vendor’s documentation for information about creating the 
database, including creating a schema repository, login, and tablespace. Be sure to install the correct 
version and patches. 

✦ Configure the database by completing the following tasks: 
Setting Database Parameters in Oracle on page 51

Rolling Back or Undoing Changes in Oracle on page 52

Granting Permissions in Oracle on page 52

Installing the JDBC Driver in Oracle on page 52

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows) on page 53

Setting Database Parameters in Oracle
Gentran Integration Suite requires the following parameter settings in your Oracle database:

Parameter Value

Number of open cursors greater than or equal to 2000

Database block buffers greater than or equal to 19200
Note: Sterling Commerce recommends that this be set to 0 if 

SGA memory equals greater than 0.

System Global Area (SGA) 
memory (10g only)

greater than 0
Note: Sterling Commerce recommends that the database 

block buffers be set to 0 if SGA memory equals greater 
than 0.

Shared pool size greater than or equal to 90000000

Large pool size greater than or equal to 614400

Java pool size greater than or equal to 20971520

Number of processes greater than or equal to 500

Log buffer greater than or equal to 163840

Database block size greater than or equal to 8192

Sort area size greater than or equal to 65536

Sort area retained size greater than or equal to 65536
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Rolling Back or Undoing Changes in Oracle
You can roll back or undo changes in Oracle using one of the following methods:

✦ (Oracle versions earlier than 9i) Gentran Integration Suite recommends that you configure a rollback 
segment for every four concurrent users. Each rollback segment must be extendable to 25MB. The 
value of the initial segment and the next segment can vary between 256 KB (with 5MB for optimal) 
and 10 MB (with 20 optimal). Note that these ranges will vary based on the size of your Gentran 
Integration Suite database and the number of business rules it contains.

✦ (Oracle versions 9i or later) These versions support AUTO UNDO management. It is recommended 
that you use this option. This will avoid any manual monitoring of UNDO segments.
If a server is upgraded from Oracle 8i, set the UNDO_MANAGEMENT=AUTO parameter in 
init<SID>.ora. Your database administrator needs to figure out the UNDO_RETENTION setting. 
Make sure that the file system which has the UNDOTBS1 tablespace has enough space to 
AUTOGROW.

Granting Permissions in Oracle
Grant the following permissions to the Gentran Integration Suite user:

GRANT "CONNECT" TO <USER>
GRANT SELECT_CATALOG_ROLE TO <USER>
ALTER USER <USER>DEFAULT ROLE "CONNECT",

SELECT_CATALOG_ROLE
GRANT CREATE PROCEDURE TO <USER>
GRANT CREATE TRIGGER TO <USER>
GRANT CREATE TYPE TO <USER>
GRANT EXECUTE ANY PROCEDURE TO <USER>
GRANT EXECUTE ANY TYPE TO <USER>
GRANT SELECT ANY TABLE TO <USER>
GRANT SELECT ANY DICTIONARY TO <USER>

For Oracle 10g 10.2.x, also grant the following permission:
GRANT "RESOURCE" TO <USER>;
ALTER USER <USER> DEFAULT ROLE "CONNECT","RESOURCE",SELECT_CATALOG_ROLE;

Note: If you are using Oracle AQ for Oracle 9i or Oracle 10g, then grant the 
AQ_ADMINISTRATOR_ROLE permission.

Installing the JDBC Driver in Oracle
Gentran Integration Suite requires the appropriate JDBC driver for Oracle Database 10g and Oracle 9i 
databases. These drivers are thin client based pure Java JDBC drivers. See System Requirements for 
supported version information.

The supported versions of the JDBC driver will build the correct Gentran Integration Suite directory 
structure.

Max extends Unlimited

Character set AL32UTF8

Parameter Value
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After obtaining the correct JDBC driver, record the absolute path to its location on your system. You must 
supply this absolute path when installing Gentran Integration Suite.

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows)
To enable failover in a multiple node Oracle RAC database cluster in Windows, do the following:

1. Navigate to the install_dir/install/properties directory to modify sandbox.cfg file.
2. In the sandbox.cfg file, add a new property for ORACLE_JDBC_URL, which contains the Oracle 

RAC connection URL.
The following example shows the suggested URL form and the way it is organized. However, the 
property value must be one string of text starting with ORACLE_JDBC_URL=. Your database 
administrator (DBA) can modify this URL as needed.
jdbc:oracle:thin:@

  (DESCRIPTION=

    (ADDRESS_LIST=

      (FAILOVER=ON)

      (LOAD_BALANCE=ON)

      (ADDRESS=(PROTOCOL=TCP)(HOST=myhost1)(PORT=1521))

      (ADDRESS=(PROTOCOL=TCP)(HOST=myhost2)(PORT=1521))

     )

     (CONNECT_DATA = (SERVER = DEDICATED)(SERVICE_NAME = myservicename))

   )

3. Run the setupfiles.sh command from the install_dir/install/bin directory.
4. Set the propagation delay on the RAC server to 0.

Obtaining a License File
After your company signed the sales contract with Sterling Commerce, Sterling Commerce created a license 
file containing information about your company, your system, and the packages (components), such as 
services, maps, and adapters, your company selected to use. 

The license file contains a license that is associated with your specific operating system and the IP address 
of your system. The license provides access, for 20 years from the date of issue, to the Gentran Integration 
Suite packages your company selected and is independent of your maintenance fee. Because the license is 
independent of your maintenance fee, the schedule for renewing your license and license file may be 
different than the maintenance fee schedule. 

You must download the license file before you can install Gentran Integration Suite. Follow these steps:

1. Point your Web browser to http://www.productupdates.stercomm.com.
2. Review the Welcome to Sterling Commerce Product Update page and click Next.
3. Review the Authenticate page and click Next.
Sterling Commerce, Inc. 53

http://www.productupdates.stercomm.com


Installing in a Windows Environment
4. Type the License File Key, which is case-sensitive, and click Next. If the system displays the Retrieve 
Registration dialog box and you are upgrading, you may retrieve your registration information by 
entering your previous License File Key. If you are not upgrading, then click Next.

5. Verify the registration information and click Next.
6. On the Server Details page, update the fields and click Next.

If the operating system, application server, or database server version is not listed in the respective 
lists, type the version in the respective Description of Other.
All IP addresses assigned to the server in which you are installing Gentran Integration Suite should be 
listed in the license file.

7. Verify the list of packages and the type of license selected for each package and click Next. If the list 
of packages selected or the type of license selected is not correct, then contact Customer Support to 
correct the information.

8. Scroll to the bottom of the Review and Download Package License File page and click Finish and 
Download.

9. Click Save in the File Download dialog box.
10. Accept the default location for the license file or navigate to the location where you will store the 

license file. Note the absolute path of the file location on the Preinstallation Checklist. You will need 
the absolute path to install Gentran Integration Suite.

11. Click Save.
12. Close your Web browser.

Installing in a Windows Environment
Installing Gentran Integration Suite in a Windows environment includes the following sections:

✦ Running the Installation Program in Windows on page 55
✦ Installing a Cluster Configuration in Windows on page 57
✦ Installing the Current Maintenance Patch in Windows on page 62
✦ Installing Patches in a Perimeter Server Environment on page 64
✦ Installing Patches in a Clustered Environment on page 65
✦ Installing a Hot-Fix in Windows on page 67
✦ Encrypting Database Passwords in Windows on page 68
✦ Setting Up Perimeter Servers with Gentran Integration Suite on page 68
Caution: If you are upgrading, refer first to the Upgrade Guide for the release from which you are 

upgrading (3.0/3.1, 4.0 or 4.1/4.1.1). Upgrading from Gentran Integration Suite 3.0, 3.1 and 4.0 
includes a full installation of Gentran Integration Suite 4.2, but you must follow additional steps 
in the Upgrade Guide to complete the upgrade. Upgrading from Gentran Integration Suite 4.1 
and 4.1.1 does not include an installation of Gentran Integration Suite 4.2. 
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Running the Installation Program in Windows
Note: The following instructions assume that you received an installation CD for Gentran Integration 

Suite. If you downloaded Gentran Integration Suite or a Service Pack (SP) from the Electronic 
Software Distribution (ESD) Portal, unzip the downloaded file to an empty directory. Do not change 
the directory structure of the newly unzipped files. The directory containing the unzipped files is an 
electronic image of an installation CD. Use this directory wherever there is a reference to the 
installation CD in the following instructions. Ignore any instructions to place the installation CD in 
a drive.

To install Gentran Integration Suite in a Windows environment, refer to your preinstallation checklist and 
follow the steps below. 

Note: To install more than one instance of Gentran Integration Suite on the same Windows server, you 
must install the second instance in a different directory and use a different initial port number.

During the installation, various messages are displayed, including some warning messages. These 
warning messages require no action on your part and are included so that helpful data is recorded in 
the log file.

1. If you are upgrading from Gentran Integration Suite 4.0 to Gentran Integration Suite 4.2, uninstall the 
Windows services for the previous installation using the following procedure:
a. Stop Gentran Integration Suite.
b. Change to the install_dir/bin directory for the Gentran Integration Suite 4.0 installation.
c. Double-click stopWindowsService.cmd and wait for all Gentran Integration Suite Windows 

services to stop. 
d. Double-click uninstallWindowsService.cmd and log off. This cleanly removes the old Windows 

services from the Windows cache and verifies that there are no scheduled jobs running in the 
background.

2. Close all open Windows programs and any command prompt windows.
3. Insert the Gentran Integration Suite installation CD in the appropriate drive.
4. On the installation CD, navigate to the windows\install folder.
5. Double-click setup.exe. Then click Next to start the installation program.
6. Review the license agreement, and click Yes to accept the terms.
7. You are prompted to select the type of JVM to use. Choose JDK and click Next.
8. You are prompted to choose an installation directory for Gentran Integration Suite. Click Browse and 

navigate to the folder you want to use as the installation directory. For the Windows 2000/NT server, 
the path to this directory must be 8 characters or less. For the Windows 2000/NT server, this directory 
is referred to as install_dir in subsequent prompts.

9. You are prompted to browse to the location of the license file. Select the license file, and click Next. 
If you have not installed a license file, you can minimize this window, obtain the license file, and then 
return to the installation process. See Obtaining a License File on page 53.

10. You are prompted to browse to the location of the JCE distribution file. Select the JCE distribution file, 
and click Next. The program verifies the path name.
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11. You are prompted about whether this installation is to upgrade an existing pre-4.0 Gentran Integration 
Suite installation. Answer No.

12. The system displays a command window. Leave the command window open. You can minimize the 
command window, but do not close it or the installation program cannot prompt you for information or 
display status messages.

13. The system displays a message window listing information you will need in subsequent steps. Click 
OK to continue.

14. You are prompted about overriding the host IP address for this installation.

To accept the default host IP address, click Next.

To specify another host IP address, enter the IP address you want to use. Click Next.

15. Type the administrative e-mail address to which you want system alert messages to be sent. Click 
Next.

16. Type the SMTP mail server host name that you want to use for alert messages. Click Next.
17. Type the system passphrase that you want to use in both the Passphrase box and the Confirm box. 

Click Next. 
If you are upgrading from Gentran Integration Suite 4.0, use the same passphrase that you used for 
your Gentran Integration Suite 4.0 installation.

18. Type the initial port number for the application server and click Next. 
If you are upgrading from Gentran Integration Suite 4.0, use the same initial port number that you used 
for your Gentran Integration Suite 4.0 installation.
The installation creates subsequent ports based on the initial port number.
Note: The WebDAV port is set to the initial port number plus 46. For example, if the initial port is 
10000, the WebDAV port is 10046. You will need to know this port number if you plan to set up 
WebDAV support.

19. You are prompted about whether this install is to upgrade version 4.0.3-5 or higher. Select Yes.
20. Select the database you want to use and click Next.

If you select the default MySQL database, the installation continues automatically. The MySQL 
bundled with Gentran Integration Suite will be installed local to Gentran Integration Suite on the 
same server. 
If you answered Yes in step 18, enter the location of the previous MySQL database when 
prompted.

If you select Microsoft SQL Server, enter the following information and click Next:

• Database host name
• Database host port number
• Database name
• User ID
• Password
• Password confirmation
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If you select Oracle, you are asked whether the Oracle instance is being used for an upgrade. 

• If your answer is Yes, refer to the Gentran Integration Suite Upgrade Guide before you answer 
subsequent prompts, including a prompt about whether you are using BLOB data in your Oracle 
database.
• If you are not upgrading, answer No.
Enter the following information and click Next:
• Database host name
• Database host port number
• Database name
• User ID
• Password
• Password confirmation

21. If you selected Oracle or Microsoft SQL Server as your database, verify that you have the required 
JDBC drivers installed.

If you are using an Oracle database, verify that you have the required Oracle JDBC driver file 
copied to a local folder on your computer. Then answer the following prompts:
• Browse to the location of the JDBC driver file. Select the file and click Open.
• In the Version Number field, type 1_2 and click Next. 

If you are using a SQL Server database, verify that you have the required MSSQL JDBC driver 
files copied to a local folder on your computer. Then answer the following prompts:
• Browse to the location of the MSSQLServer.jar file. Select the file, and click Open.
• In the Version Number field, type 4_0 and click Next.

22. Click Yes to proceed with the installation. 
23. The installation completes automatically. When the installation is finished, the system places an icon 

on your Windows desktop and displays a message that Gentran Integration Suite was successfully 
installed. Click OK. Click Next. Click Finish.
If you encounter problems or errors during installation, see Troubleshooting: Windows Environment 
on page 77.

Installing a Cluster Configuration in Windows
Installing Gentran Integration Suite nodes is similar to a standard Gentran Integration Suite installation, with 
the following restrictions on all nodes:

✦ All nodes must use the same database.
✦ All nodes must use the same passphrase.
✦ You must install and start the nodes sequentially, one at a time, starting with the first node.
✦ When upgrading, all cluster nodes must use the regular upgrade procedure. All nodes must upgraded to 

the same level before setting up and starting the cluster.
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To install Gentran Integration Suite in a cluster configuration, do the following:

1. Install the first node (node1) as you would for a regular Gentran Integration Suite installation.
2. Starting from node2, start the installation as normally done for all Gentran Integration Suite 

installations. 
3. When prompted "Is this installation going to be used to upgrade an existing pre-4.0 GIS installation?", 

press "No".
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4. When prompted "Is this install to upgrade version 4.0.3-5 or higher?", press "Yes".
For each node after node1, also perform these steps:
Note: The failure error message in the next step applies only to Gentran Integration Suite 4.0. The 
failure error message does not appear for Gentran Integration Suite 3.x and 4.1. For those versions, go 
to the next step.
a. When the patch installation portion of the installation fails with the following message, go to the 

next step:
Controller loading lists...
Error '255' installing service files.
ERROR: Installation failed '255'
This error message writes the following information to the security.log file:
[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE Product 
version doesn't match feature set version.

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE LM.refresh 
caught securityexception

java.lang.SecurityException: Product version 4.1 does not match feature 
map version 4.2.0-42XX

        at com.company.security.lc.LM.loadMap(LM.java:2355)

        at com.company.security.lc.LM.refresh(LM.java:2908)

        at com.company.security.lc.LM.<clinit>(LM.java:3305)

        at 
com.company.server.install.module_loader.ServiceInstall.install(ServiceI
nstall.java:184)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.doIt(Servi
ceInstallDriver.java:164)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.main(Servi
ceInstallDriver.java:63)

        at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method)

        at 
sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.jav
a:39)

        at 
sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessor
Impl.java:25)

        at java.lang.reflect.Method.invoke(Method.java:324)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.doIt
(ServiceInstallBootstrapper.java:94)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.main
(ServiceInstallBootstrapper.java:58)
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[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE 
*************************************

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE License check 
failed at 0

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE 
*************************************

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE LM.refresh 
caught securityexception exit SI

[YYYY-MM-DD HH:MM:SS.SSS] ERROR 000000000000 GLOBAL_SCOPE LM.refresh 
caught securityexception at start up exit SI

java.lang.SecurityException: Product version 4.1 does not match feature 
map version 4.2.0-42XX

        at com.company.security.lc.LM.loadMap(LM.java:2355)

        at com.company.security.lc.LM.refresh(LM.java:2908)

        at com.company.security.lc.LM.<clinit>(LM.java:3305)

        at 
com.company.server.install.module_loader.ServiceInstall.install(ServiceI
nstall.java:184)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.doIt(Servi
ceInstallDriver.java:164)

        at 
com.company.server.install.module_loader.ServiceInstallDriver.main(Servi
ceInstallDriver.java:63)

        at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method)

        at 
sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.jav
a:39)

        at 
sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessor
Impl.java:25)

        at java.lang.reflect.Method.invoke(Method.java:324)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.doIt
(ServiceInstallBootstrapper.java:94)

        at 
com.company.server.install.module_loader.ServiceInstallBootstrapper.main
(ServiceInstallBootstrapper.java:58)

b. Copy install_dir/bin/FeatureSet.xml from the primary node to install_dir/bin on 
the secondary node.

c. Install the patch on the secondary node using the following command:
InstallService.cmd absolutepath\si_engine_4204.jar (or higher)

5. Complete the rest of the installation process as normally done for a Windows Gentran Integration Suite 
installation.
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6. On each node, starting with "node1", perform cluster configuration by running the command 
"startCluster.cmd nodeNumber" from the Gentran Integration Suite install bin directory where the 
nodeNumber is the sequential number assigned to each node starting with 1.

To dynamically add new nodes to the cluster, install the new node in the same way that you installed node2 
in a new cluster installation. Run the startCluster.cmd command with the new node number.

Multiple Nodes
Gentran Integration Suite supports the installation of multiple nodes on the same machine. Each node will 
be configured on a different port range. Install other nodes in the same machine on a different port range 
following the installation instructions discussed in the previous section. Once installation is complete and 
cluster setup is complete go to properties directory of the node installed and change "multicastBasePort" in 
noapp.properties to point to node1's "multicastBasePort".

Custom Configurations
As part of a default cluster configuration, certain values in the database for service or adapter configurations, 
default document storage type, etc., are updated to get the cluster working. The default settings include no 
shared or mounted file system available with “line of sight” from all cluster nodes, etc. Certain service or 
adapter configurations are forcibly deployed on node1 and default document storage type is set up to 
“Database” for all business processes.

After you install the cluster and evaluate the customer configurations and requirements, the above 
conditions might change and custom configurations will be incorporated. To keep these custom 
configuration changes from being overwritten, the following cluster configuration script has an option to 
update the database:

startCluster.cmd nodeNumber true\false

✦ nodeNumber is the cluster node number
✦ Type true to perform database update and false to prevent any database updates.
The first time you configure a Gentran Integration Suite cluster, run startCluster.cmd with the database 
update option set to true to have all cluster-related configurations take effect.

startCluster.cmd nodeNumber true

For cluster configurations after the first configuration, you can execute the startCluster.cmd command with 
the database update option turned off. This prevents any configuration changes from affecting the system, 
especially after installing patches/hot-fixes.

startCluster.cmd nodeNumber false

Multicast Configurations
All Gentran Integration Suite cluster nodes communicate with each other through multicast on a specific IP 
address and port. The multicast ports are configured based on the Gentran Integration Suite installation base 
port. All Gentran Integration Suite clusters that are on the same subnet configured on the same Gentran 
Integration Suite base port will end multicasting messages on the same multicast IP address and port. 

To avoid this, each Gentran Integration Suite cluster on the same subnet needs to be configured on different 
base ports.  Install your clusters on different port ranges or on different network segments with multicast 
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forwarding restricted, so that they will not interfere with each other. The default multicast address used in 
Gentran Integration Suite release 4.2 is "239.255.166.17". This address is configurable, with a port range of 
10 ports, starting with the multicast base port for the instance.

All nodes participating in the same cluster must be installed on the same multicast base port (the 
multicastBasePort property in the noapp.properties file).  This is usually computed from the system base 
(non-multicast) port, but can be configured separately in the noapp.properties file, to allow different nodes 
in a cluster to be installed at different (non-multicast) port ranges.  Also, all the nodes in the cluster should 
be installed in the same subnet.

Configuring Shared File System as Document Storage
In a Gentran Integration Suite cluster, the default document storage is database, so that all of the nodes in 
the cluster have line of sight to the documents to access and process the documents. However, using the 
database for document storage has performance implications over using the file system for document 
storage. 

To use the file system as document storage in cluster, the file system needs to be a shared/mounted/clustered 
file system with all nodes having line of sight to the file system. 

For each Gentran Integration Suite node, follow this procedure to configure a shared file system in a Gentran 
Integration Suite cluster:

1. Go to install/properties dir.
2. Change the document_dir property in jdbc.properties to point to the shared file system directory 

configured to store the documents.
3. Restart Gentran Integration Suite (all nodes).

This configures a shared file system directory as document storage.

Installing the Current Maintenance Patch in Windows
Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each patch 
contains the fixes from previous patches, you only need to install the most recent patch. 

To help you determine which patch to use, the files are named using the following naming convention: 

si_engine_<build_number>.jar

For example, a file named si_engine_1976.jar is the patch for build 1976 for Gentran Integration Suite 4.1, 
which is labeled Gentran Integration Suite 4.2 in the user interface.

Information about a patch is located in a text file with a similar name. The naming convention for text files 
containing information about a particular patch is:

si_engine_<build_number>_patch_info.txt

For example, a file named si_engine_1976_patch_info.txt contains information about build 1976 for 
Gentran Integration Suite 4.1, which is labeled Gentran Integration Suite 4.2 in the user interface.

Both the jar and the txt files are available on the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. You should periodically check the web site to verify 
that you have the most recent patch.
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Note: The patch installation may use one or more patch property override files. These files will be named 
propertyFile_patch.properties. Do not alter these files. 
Additionally, property changes made directly in .properties or .properties.in files may be overwritten 
during the patch installation. Properties overridden using the customer_overrides.properties file are 
not affected.

To install the latest patch for Gentran Integration Suite in a Windows environment, follow the steps below.

1. Go to the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. 

2. Download the most recent patch file for your version of Gentran Integration Suite and record the 
absolute path to the downloaded file. If you use FTP, use Binary mode. Do not rename the file. Make 
sure that you download the file to your local machine (for example, to your installation bin directory), 
and not to a network drive. Use the full path to your local machine when you install the patch.

3. If you are using a database other than MySQL, verify that the database server is up and ready to accept 
connections.

4. Stop Gentran Integration Suite.
5. Perform a full backup of the Gentran Integration Suite installation directory, including all 

subdirectories. Also back up your database.
6. Is the password encrypted? If Yes, decrypt the password. See Decrypting a Password (Windows) in the 

Security Guide.
7. If you edited any property files, ensure that the associated .properties.in files have the most current 

changes. Property files will be overridden with the contents of the associated .properties.in files during 
the patch installation.

8. Close all command prompt windows.
9. Install the patch using the following commands:

a. Open a command prompt window.
b. Change to the directory where Gentran Integration Suite is installed and run the following 

command:
<install_dir>\bin

c. Run the following command to install the patch:
InstallService.cmd 
<path>\si_<version>_sp_0_patch_<number>_<app_server>.jar

where:
<path> = Fully qualified path to maintenance patch file
<version> = Gentran Integration Suite Version
<number> = Patch number
<app_server> = Application Server
Example: InstallService.cmd c:\patch\si_22_sp_0_patch_1_jboss.jar

Information about the patch installation is automatically logged to install_dir\logs\InstallService.log.
If the patch attempts to modify the database schema and the modification fails, you will receive an 
error message about the failure. The message will provide the error message code from the database 
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and the SQL command that failed. The failure information is also logged to the system.log file and to 
the patch.log file. If you cannot determine whether the failure can be safely ignored, contact Sterling 
Commerce Customer Support for assistance. Choose one of the following options when prompted:

Continue – If you determine that the failure can be safely ignored, continue with the patch 
installation.

Stop – Stop the patch installation. You should always contact Sterling Commerce Customer 
Support for assistance before choosing this option.

Retry – Choose this option to retry the failed command.

10. If you decrypted the password, re-encrypt the password. 
11. Restart Gentran Integration Suite.

If you are using a perimeter server in a DMZ, see Installing Patches in a Perimeter Server Environment on 
page 64.

Installing Patches in a Perimeter Server Environment
Perimeter servers in a DMZ are not automatically updated by a service pack or patch. You must reinstall the 
perimeter server using the new perimeter server installation file supplied with the service pack or patch. You 
can determine the proper answers to most of the questions asked during the perimeter server installation by 
reading a script in your previous installation directory. The name of the script is installPS.cmd.

To Update a DMZ Perimeter Server in a Windows Environment
Caution: Do not use spaces in the name of the perimeter server installation directory.
1. Locate the ps42service_pack-patch.jar file in the install_dir\packages directory. For maintenance 

patches, obtain the file from the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. These patch files will have have a longer name 
that identifies the associated maintenance patch. For example, ps42-1976.jar.

2. Copy the file to the home directory or base directory on the DMZ server.
3. Stop the perimeter server using the stopPs.cmd command.
4. Close all open Windows applications.
5. To begin the installation, enter absolutepath\bin\java -jar ps42service_pack-patch.jar

If you are using FTP to copy the file, use Binary mode.
The program verifies the operating system and required patch level and the location and version of the 
JDK.

6. Type the full path for the installation directory.
7. The program verifies the amount of available disk space.
8. Type the TCP/IP address or DNS name for the internal interface, or press Enter to use a wildcard 

address.
9. Verify the TCP/IP address or DNS name for the internal interface.
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10. Type the TCP/IP address or DNS name for the external interface, or press Enter to use a wildcard 
address.

11. Verify the TCP/IP address or DNS name for the external interface.
12. Type the port that the perimeter server will use to listen for the connection from Gentran Integration 

Suite. The port number must be a valid number between 1 and 65535.
13. Verify the port number.
14. Type the maximum amount of heap space the JVM should allocate in MB, or press Enter to use the 

default value of 512MB. Valid values range from 64 to 2048MB.
15. Verify the maximum amount of heap space the JVM should allocate.
16. The message, Installation of Perimeter Service is finished, displays when the perimeter server is 

installed.
17. Change to the installation directory.
18. Type installPS.cmd to begin the installation.
19. Type startPSService.cmd to start the perimeter server.

Installing Patches in a Clustered Environment
All nodes in a cluster must be patched to the same level. You should stop all nodes in the cluster before 
installing a patch and then install the patch on each node.

It is possible, in some cases, to apply patches to nodes while others are still processing. However, a patch 
containing any of the following requires the entire cluster to be down:

✦ Critical cluster functionality
✦ Engine-related changes
✦ Changes to the database
Attempting to apply patches while part of the cluster is running should only be done with the advice of 
Sterling Commerce Customer Support.

Updating the Database (dbupdate) with the startCluster Command
The startCluster.cmd nodeNumber command on node 1 will automatically update the database, unless 
you use the command startCluster.cmd 1 false. The startCluster.cmd nodeNumber command on all other 
nodes will not update the database.

When you configure the Gentran Integration Suite cluster for the first time, you should run the 
startCluster.cmd command with the database update value set to true (startCluster.cmd 1 true), or just 
startCluster.cmd 1, since on node 1, dbupdate defaults to true. This makes all cluster-related 
configurations take effect. The database update will synchronize the scheduled jobs between the nodes by 
assigning them all to node 1. 

The startCluster.cmd command with the database update value turned off (startCluster.cmd 1 false) 
prevents any configuration changes from affecting the system, especially after you install patches or 
hot-fixes.

For current database updates, the following services are tied to node1:
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✦ Schedule
✦ FileSystem
✦ CmdLine
✦ CDServerAdapter
✦ CDAdapter
✦ CDRequesterAdapter
✦ CEUServerAdapter
✦ HttpServerAdapter
✦ B2B_HTTP_COMMUNICATIONS_ADAPTER
✦ HTTP_COMMUNICATIONS_ADAPTER
✦ HTTPClientAdapter
✦ FTPClientAdapter
✦ FtpServerAdapter
✦ SFTPClientAdapter
The default storage of the following services is set to the database:

✦ HttpServerAdapter
✦ CEUServerExtractServiceType
✦ CDSERVER_ADAPTER
The default storage of all business processes is set to the database.

Applying a Patch in a Clustered Environment Stopping the Whole Cluster
For a critical patch where the whole cluster needs to be down, use the following process. 

1. Stop the whole cluster.
2. Install the patch on each node by running the following command from the install_dir\bin directory:

InstallService.cmd <si_engine_####.jar>
Apply the patch to node1 first, and then to the subsequent nodes: node2, node3, etc. For node1, 
REINIT_DB=true in sandbox.cfg. For subsequent nodes, REINIT_DB=false, which prevents database 
updates from repeating on each node's patch installation. This is automatically set during the patch 
installation for all nodes except node1 if the installation is done using the nodbinit option. 

3. Set up the cluster for each node by running startCluster.cmd nodeNumber.

Applying a Patch in a Clustered Environment Stopping One Node at a Time
For a patch where you can stop the cluster one node at a time, use the following process.

Note: Apply the patch to node1 first, and then to the subsequent nodes: node2, node3, etc. 
1. Shut down the node using the hardstop.cmd command.

Wait until the perimeter server of the node is completely down before installing the patch.
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2. Install the patch by running the following command from the install_dir/bin directory:
InstallService.cmd patch_file_name
For node1, REINIT_DB=true in sandbox.cfg. For subsequent nodes, REINIT_DB=false, which 
prevents database updates from repeating on each node's patch installation. This is automatically set 
during the patch installation for all nodes except node1 if the installation is done using the nodbinit 
option. 

3. Set up the cluster. Run startCluster.cmd nodeNumber (Windows).
4. Open install_dir\properties\sandbox.cfg in a text editor. Perform the following steps:

a. If REINIT_DB=true, back up the sandbox.cfg file and change REINIT to false.
b. Save and close the sandbox.cfg file.
This prevents database updates from being repeated for each node.

5. Repeat steps 1 through 4 for each subsequent node.

Installing a Hot-Fix in Windows
After you install Gentran Integration Suite, you may need to install a hot-fix. A hot-fix is one or more fixes 
applied to a specific existing patch.

Before Installing a Hot-Fix
Before you can install a hot-fix developed for your company, you must have completed the following:

✦ Received the file name of the caseid.jar to install from Sterling Commerce Customer Support
✦ Created a full backup of Gentran Integration Suite 
✦ Created a full backup of your database

Installing a Hot-Fix
To install a hot-fix on the Windows host system:

1. Is the password encrypted? If Yes, decrypt the password. See Decrypting a Password (Windows) in the 
Role-Based Security manual.
Apply the hot-fix to node 1 first, and then to the subsequent nodes: node 2, node 3, etc. For node 1, 
REINIT_DB is true in install_dir\install\properties\sandbox.cfg. For subsequent nodes, REINIT_DB 
is false, which prevents database updates from repeating on each node's hot-fix installation.

2. Open a command line session. Click the Windows Start menu and select Programs > Accessories > 
Command Prompt.

3. At the command line, type ftp theworld.stercomm.com.
4. Type your user name and password. If you do not know your user name and password, contact Sterling 

Commerce Customer Support.
5. Type bin and press Enter to select Binary as your transfer mode.
6. At the FTP prompt, type get ccaseid.jar, where caseid is the ID you received from Customer Support.
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7. Shut down Gentran Integration Suite. For more information, see Stopping Gentran Integration Suite 
on page 73.

8. Open a command prompt and change the directory to install_dir\bin.
9. Type InstallService <path to ccaseid.jar>\ccaseid.jar to install the hot-fix.
10. If you decrypted the password in step 1, re-encrypt the password. 
11. In the command prompt, change the directory to install_dir\bin.
12. Type uninstallWindowsService.cmd and log off. This removes previous Gentran Integration Suite 

Windows services from the Windows cache.
13. At the command prompt, type your user name and password.
14. Change the directory to install_dir\bin.
15. Type installWindowsService.cmd to install the Gentran Integration Suite Windows services.
16. Restart Gentran Integration Suite. For more information, see Starting Gentran Integration Suite in 

Windows on page 71.
17. In the install_dir\bin directory, run dump_info.cmd to verify that the hot-fix was successfully installed.

Encrypting Database Passwords in Windows
Gentran Integration Suite uses a password to connect to the database being used. Currently, Gentran 
Integration Suite stores the password as clear text in a property file on the system. If the security policies at 
your company require you to encrypt these passwords, you can do so after you install Gentran Integration 
Suite. Encrypting these passwords is optional. 

To encrypt the database password used by Gentran Integration Suite in Windows, follow these steps:

1. Stop Gentran Integration Suite.
2. Go to /install_dir/bin/.
3. Run enccfgs.cmd. 
4. Run setupfiles.cmd.
5. Run deployer.cmd.
6. Run run.cmd to start Gentran Integration Suite. 
7. Enter your passphrase.

Setting Up Perimeter Servers with Gentran Integration Suite 
Using a perimeter server with Gentran Integration Suite is optional. 

A perimeter server is a software tool for communications management that is installed in a DMZ. The 
perimeter server manages the communications flow between outer layers of your network and Gentran 
Integration Suite’s TCP-based transport adapters. A perimeter server can solve problems with network 
congestion, security, and scalability, especially in high- volume, Internet-gateway environments. A 
perimeter server requires a corresponding perimeter client. 
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The Gentran Integration Suite installation program installs a perimeter client and a local mode server. The 
local mode server is useful for testing purposes or in environments that do not require a DMZ solution. 
However, if you require high-volume, secure connections, you must install a perimeter server in a DMZ.

When you install a perimeter server, use these guidelines:

✦ Licensing for a perimeter server is determined by the licensing restrictions on the corresponding 
transport adapters in Gentran Integration Suite: FTP Server, FTP Client, HTTP Server, HTTP Client, 
SFTP Server, SFTP Client, Connect:Direct Server, and Connect:Direct Requester.

✦ Each perimeter server is limited to two TCP/IP addresses: internal interface and external interface. 
Internal interface is the TCP/IP address that the perimeter server uses to communicate with Gentran 
Integration Suite. External interface is the TCP/IP address that the perimeter server uses to 
communicate with trading partners. 
To use additional TCP/IP addresses, install additional perimeter servers.

✦ You may have multiple perimeter servers installed on the same computer interacting with one instance 
of Gentran Integration Suite. To install a perimeter server on a computer with an existing instance, 
install the new perimeter server in a different installation directory.

✦ The combination of internal TCP/IP address and port must be unique for all perimeter servers installed 
on one computer.

If a perimeter server is installed using the wildcard address, then all ports must be unique.

If a perimeter server is installed using the wildcard address, then its port is not available for use by 
adapters that use the server or any other perimeter server on that computer. 

The internal and external interface may use the same TCP/IP address. However, the port used by 
the perimeter server is not available to the adapters that use the server.

Installing a Perimeter Server in a Windows Environment
To install a perimeter server in a Windows environment: 

1. Close all open Windows programs.
2. Insert the Gentran Integration Suite installation CD into the appropriate drive.
3. Open a DOS command window.
4. Copy the ps42service_pack-patch.jar installation files from the installation CD to your home directory 

or base directory. If you are using FTP to copy the file, be sure your session is set to binary mode.
5. To begin the installation, enter the absolute path to the following jar file:

\absolutepath\bin\java -jar ps42service_pack-patch.jar
The program verifies the operating system and required patch level and the location and version of the 
JDK.

6. Enter the name for the installation directory.
The program verifies the amount of available disk space.

7. At the prompt Is this server in a less secure network than the integration server?, do one of the 
following:
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If you are installing the perimeter server in a less secure location than the integration server (for 
example, in a DMZ when Gentran Integration Suite is installed in the secure network zone), type y 
and press Enter.

If you are installing the perimeter server in a more secure location than the integration server (for 
example, in a secure network zone when Gentran Integration Suite is installed in a second tier 
DMZ), type n and press Enter.

8. Enter the TCP/IP address or DNS name for the internal interface, or press Enter to use a wildcard 
address.

9. Verify the TCP/IP address or DNS name for the internal interface.
10. Enter the TCP/IP address or DNS name for the external interface, or press Enter to use a wildcard 

address.
11. Verify the TCP/IP address or DNS name for the external interface.
12. Take one of the following actions, based on the entry at Step 7:

If you typed y at Step 7, enter the port that the perimeter server will use to listen for the connection 
from the Gentran Integration Suite. The port number must be a valid number between 1 and 65535.

If you typed n at Step 7, enter and verify both the IP address (or host name) of the Gentran 
Integration Suite instance to which this perimeter server will connect, and the network port that 
this Gentran Integration Suite instance will be listening on.

13. Verify that the port is correct.
14. Enter the maximum amount of heap space, in MB, that the JVM should allocate, or press Enter to use 

the default size of 512MB. Valid values range from 64 to 2048MB.
15. Verify the heap size.

When the perimeter server is installed, the following message displays:
Installation of Perimeter Service is finished

16. Change to the installation directory.
17. Enter installPS.cmd to begin the installation. 
18. Enter startPSService.cmd to start the perimeter server.

Starting and Stopping Perimeter Servers in Windows
To start a perimeter server in Windows, use the startPSService.cmd command.

To stop a perimeter server in Windows, use the stopPSService.cmd command.

Postinstallation in a Windows Environment
After installing Gentran Integration Suite, you should complete the following tasks:

✦ Starting Gentran Integration Suite in Windows on page 71
✦ Accessing Gentran Integration Suite on page 71
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✦ Validating the Installation on page 73
✦ Downloading Gentran Integration Suite Tools on page 73
✦ Performing Initial Administrative Setups in Gentran Integration Suite on page 73
✦ Stopping Gentran Integration Suite on page 73
✦ Starting or Stopping the Cluster Environment on page 74
✦ Cluster Environment Verification on page 74

Starting Gentran Integration Suite in Windows
To start Gentran Integration Suite in a Windows environment, double-click the Gentran Integration Suite 
icon on your Windows desktop. Gentran Integration Suite starts running. 

Note: It may take several minutes for Gentran Integration Suite components to initialize and start up.

If Gentran Integration Suite does not start or if you receive a message about an invalid or corrupt license 
file, go to Troubleshooting: Windows Environment on page 77.

When startup is finished, a message like the following is displayed:

Open your Web browser to http://host:port/dashboard, where host:port is the IP address and port number 
where Gentran Integration Suite resides on your system.

Make a note of the URL address so you can access Gentran Integration Suite later.

Accessing Gentran Integration Suite 

To log in to Gentran Integration Suite the first time, follow these steps:

1. Be sure that Gentran Integration Suite is started and running.
2. Open a browser window and enter the address displayed at the end of startup.
3. The login page for Gentran Integration Suite displays. 
4. Type the default user ID and password. The default login is at an administrative level. One of your first 

tasks as an administrator is to change the administrative password and to register other users with other 
levels of permission.

Technical Note: Changes to Network Interface Bindings

System Default login

Gentran Integration Suite User ID: admin
Password: password

AS2 Edition User ID: as2_user
Password: password

UCCnet Edition User ID: uccnet_user
Password: password
Sterling Commerce, Inc. 71



Postinstallation in a Windows Environment
To increase the security of the Administrator Console user interface, Gentran Integration Suite Version 4.2 
binds only to specific network interfaces. By default, previous versions had been bound to all network 
interfaces. After installing, if the URL for Gentran Integration Suite returns Page cannot be displayed, you 
can adjust property settings to correct the problem.

1. On the server where Gentran Integration Suite resides, edit the noapp.properties.in file.
a. Locate the admin_host parameter. The default settings are as follows:

hostname1 is the name of primary network interface, the one given highest priority by Gentran 
Integration Suite.
localhost is the name of the network interface on the server where Gentran Integration Suite 
resides.
Default entries

admin_host.1    = hostname1

admin_host.2    = localhost

b. Correct the parameters.
If no interface is being displayed, edit hostname1 so that it correctly identifies the primary network 
interface that accesses Gentran Integration Suite.

If an additional network interface needs to access Gentran Integration Suite, add an additional 
admin_host entry, as shown below. 
Edited entries

admin_host.1    = hostname1

admin_host.2    = localhost

admin_host.3    = hostname2

2. Stop Gentran Integration Suite.
3. Run the setupfiles.cmd utility located in the install_dir\bin directory.
4. Restart Gentran Integration Suite.

For the Dashboard user interface, Gentran Integration Suite Version 4.2 provides unrestricted binding to 
network interfaces through the perimeter server. To restrict access to the Dashboard user interface, you can 
adjust property settings so that only one network interface accesses Gentran Integration Suite. 

1. On the server where Gentran Integration Suite resides, edit the perimeter.properties.in file.
a. Locate the localmode.interface parameter. The default setting is unrestricted, as shown below. 

Unrestricted Setting (Default)

localmode.interface=*

b. To restrict access to the Dashboard, enter the network interface that you want Gentran Integration 
Suite to support.
Restricted Setting

localmode.interface=hostname1

2. Stop Gentran Integration Suite.
3. Run the setupfiles.cmd utility located in the install_dir\bin directory.
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4. Restart Gentran Integration Suite.

Validating the Installation
After you install, start, and log in to Gentran Integration Suite the first time, you can validate the installation 
by testing a sample business process. Follow these steps:

1. Open a browser window and enter the address for Gentran Integration Suite. This address was 
displayed at the end of startup.

2. Enter your user login and password. 
3. From the Administration menu, select Business Processes > Manager.
4. In the Process Name field, type Validation_Sample_BPML and click Go!
5. Click execution manager.
6. Click execute.
7. Click Go! You see the Status: Success message in the upper left side of the page.

Downloading Gentran Integration Suite Tools
Gentran Integration Suite includes four tools that run on a desktop or personal computer. After you install, 
start, and access Gentran Integration Suite, you can install the following tools by downloading them from 
within Gentran Integration Suite: 

✦ Map Editor and associated EDI and CII standards
✦ Graphical Process Modeler
✦ Web Template Designer
✦ Service Developer’s Kit
Conflicting IP addresses can cause problems when you download a desktop tool. See Troubleshooting: 
Windows Environment on page 77.

Performing Initial Administrative Setups in Gentran Integration Suite 
If you are installing Gentran Integration Suite for the first time, you need to perform some initial 
administrative setups before users can use the application. For example, the system administrator for 
Gentran Integration Suite must register users, grant permissions, and run several performance reports so that 
benchmarks are established for tuning the system in the future. 

Stopping Gentran Integration Suite 

To stop Gentran Integration Suite in a Windows environment, follow these steps:

1. Open Gentran Integration Suite.
2. From the Administration menu, select Operations > System > Troubleshooter.
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3. Click Stop the System and wait for shutdown to complete.

Starting or Stopping the Cluster Environment
Note: To run Gentran Integration Suite cluster, you need to get a valid Gentran Integration Suite license 

for multiple IP address of all the nodes where Gentran Integration Suite will be installed and 
configured as a cluster.

You can start the Gentran Integration Suite cluster environment by starting Gentran Integration Suite on 
each node, starting with node1 (It is recommended to start node1 first.):

You can stop a Gentran Integration Suite cluster by using one of the following options:

✦ hardstop.cmd from each node. This stops all Gentran Integration Suite Windows Services for each 
node.

✦ softstop.cmd from each node. This does a regular cleanup and shutdown of all components.
Caution: Running softstop.cmd command in a multiple node (clustered) environment will suspend all 

scheduled business processes.  It is recommended to run the hardstop.cmd command when 
stopping individual nodes of a cluster.

✦ Shut down the whole cluster by selecting Operations > System > Troubleshooter, and then clicking 
the Stop the System link.

✦ Shut down specific nodes by selecting Operations > System > Troubleshooter, and then clicking the 
shutdown link.

Cluster Environment Verification
This section explains the verification process for the Gentran Integration Suite cluster environment.

✦ Verify the following properties:
The property CLUSTER=true is included in sandbox.cfg 

The cluster property in centralops.properties and noapp.properties is true and the clustered_env 
property in ui.properties is set to true

✦ Using the System Troubleshooter, you can verify the cluster environment by viewing the following 
information for each node:
a. Queue information 
b. JNDI Tree for each node
c. Host, state, status, adapters, and memory usage information
d. Perimeter Server
e. Shows adapter status for each node with a dropdown box listing all nodes in cluster  

✦ Operations/Troubleshooter Admin UI page displays all the cluster nodes, ops URL, node URL, the 
status of the node and which node holds the token.

✦ The Operations/System/Logs UI information is useful for tracking the errors and exceptions in the 
system. In a clustered environment, the logs are provided for each node. A dropdown lists all the nodes 
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and by selecting the node the logs corresponding to the nodes is displayed. You can see each log item 
in this page for each node after all nodes start.

✦ The Activity Monitor UI provides the status of running business process and scheduled services. Using 
this feature, you can monitor all service activities including the node on which each activity is 
executing. 

✦ The Operations/System/ Troubleshooter Admin UI, by selecting the Threads for a node, the pop-up 
window displays current threads that running on specific node.

Uninstalling Gentran Integration Suite from a Windows 
Environment
When you uninstall Gentran Integration Suite, the following components are affected:

✦ The Gentran Integration Suite application is automatically removed from the server.
✦ The MySQL database is automatically removed from the server (if you are using MySQL).
Additionally, you may perform the following tasks:

✦ Manually remove the JDK that was installed
✦ Manually remove Java WebStart and any desktop tools that were downloaded
✦ Free any database space in Oracle or SQL Server databases
To uninstall Gentran Integration Suite from a Windows environment, follow these steps:

1. Stop Gentran Integration Suite and wait for shutdown to complete.
2. Run install_dir\bin\uninstallWindowsService.cmd to remove the following Windows services:

Gentran Integration Suite 

Opsserver

Noapp server

WebDav server

MySQL server

You should receive a message stating that the services were successfully removed. To verify their 
removal, open the Services window:
a. Select Start > Settings > Control Panel.
b. Click Administrative Tools > Services. 
If the services were not removed, you must delete them from the Windows registry:
a. Go to the Windows registry.
b. Locate HK_LOCAL_MACHINE\System\Current Control Set\Services. 
c. Delete the keys for Gentran Integration Suite and Opsserver. These registry keys start with 

Gentran Integration Suite. 
d. Reboot to apply the registry changes.
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3. If the JDK is not being used by another application, remove it. 
a. From the Windows Start menu, select Settings > Control Panel.
b. From the Control Panel, select Add/Remove Programs.
c. In the Add/Remove Programs window, select Java 2 SDK Runtime Environment Standard 

Edition v<version number> and click Remove.
d. In the Add/Remove Programs window, select Java 2 SDK Standard Edition v<version number> 

and click Remove.
e. Close all windows and return to your desktop.

4. Remove the product installation folder from the Windows path:
a. In your Windows desktop, right-click My Computer.
b. Select Properties.
c. Click the Advanced tab.
d. Click Environment Variables.
e. In the System variables window, select Path.
f. Click Edit.

The system displays the Edit System Variable dialog box.
g. Delete the following entries located in Variable Value.

<install_dir>\SI\lib\jnipass\1_0\windows;
<install_dir>\mysql2\SI\packages\lib\jni;
<install_dir>\mysql2\SI\packages\lib\jni\windows2000

h. Click OK.
i. Close all windows to return to your desktop.

5. Delete the folder where Gentran Integration Suite was installed, including all subfolders. For example, 
delete C:\SterlingCommerce and its subfolders.

6. If you use an Oracle or SQL Server database, these remain intact even after you remove Gentran 
Integration Suite from the server. If you no longer want to reference the data, contact your database 
administrator about removing the unwanted tables and recovering the database space where Gentran 
Integration Suite resided.

7. After you remove Gentran Integration Suite from the server, you can remove Java WebStart and any 
tools that were downloaded to the desktop:

Map Editor and associated EDI and CII standards

Graphical Process Modeler

Web Template Designer

Service Developer’s Kit
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Troubleshooting: Windows Environment

Situation Message or Symptom Explanation/Resolution

Installing You encounter errors or problems 
during installation.

Explanation
Installation creates two log files, one for the first (bootstrap) 
phase and a second for the actual installation phase.
Resolution
Examine the log files generated during installation:

install_dir\bootstrap.log

install_dir\SI\installSI.log

Installing During installation, you select the 
destination directory and the 
installation program stops running.

Explanation
The command window was closed after you selected the 
destination directory.
Resolution
Delete the destination directory and re-start the installation 
process. Do not close the command window.

Installing You started the installation program 
but realize that the license file has not 
been downloaded.

Resolution
Minimize the installation window, obtain the license file, and 
then continue with the installation procedure. See Obtaining a 
License File on page 53.

Installing During installation, you identify the 
initial port number and then see the 
message: Port number is already in 
use.

Resolution
Choose one:

Use a different port number.

Stop the application that is using the port number you want 
to use.

Installing During installation, you enter database 
information and see the message: 
Information is incorrect.

Explanation
One or more of the criteria for the database is incorrect. 
Resolution
Click Back to redisplay the dialog box that asks for the 
database information. Correct the error and click Next.
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Installing Installation appears to complete 
successfully, but Gentran Integration 
Suite services are not installed.

Explanation
You may have reinstalled Gentran Integration Suite on a 
Windows server and chosen the same initial port. 
Resolution
If this is the case, either reinstall Gentran Integration Suite in a 
different directory using a different port, or follow the steps 
below to uninstall the existing Gentran Integration Suite 
services prior to reinstalling Gentran Integration Suite.
1 Run install_dir\bin\stopWindowsService.cmd and 

wait for all Gentran Integration Suite Windows services 
to stop. 

2 Run install_dir\bin\uninstallWindowsService.cmd 
and log off. This cleanly removes the old Windows 
services from Windows cache and verifies that there 
are no scheduled jobs running in the background.

3 Delete the install_dir directory. 

4 You can now install the new version of Gentran 
Integration Suite at the same port. 

Starting If Gentran Integration Suite does not 
start, examine the log file in 
<install_dir> \SI\logs for an invalid or 
corrupt license file. 

Resolution
Obtain the license file. Then restart Gentran Integration Suite. 
See Obtaining a License File on page 53.

Installing a 
desktop 
tool or 
resource

Cannot download any of the following:

Map Editor

Graphical Process Modeler

Web Template Designer

Service Developer’s Kit

Explanation
When you install Gentran Integration Suite, system files are 
created that contain an internal IP address. If you install 
Gentran Integration Suite behind a firewall, and your firewall is 
configured to accept an external IP address from a client 
computer, you may not be able to download the desktop tools 
and resources. The firewall will reject the IP address from a 
client residing outside of the firewall. 
Resolution
Modify the system files that contain the invalid IP address. 
Follow these steps:
1 Navigate to the install_dir\bin directory.
2 Enter the following command followed by the external 

IP address:
patchJNLP.cmd external_IP address

3 Stop Gentran Integration Suite. 
4 Restart Gentran Integration Suite. 

Accessing Attempts to access the URL for 
Gentran Integration Suite display the 
message: Page cannot be displayed.

See Accessing Gentran Integration Suite on page 71.

Situation Message or Symptom Explanation/Resolution
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Chapter 3

Installing in an iSeries Environment

This section includes the following topics:

✦ Preinstallation Setup Checklist for an iSeries Environment on page 79
✦ Installing in an iSeries Environment on page 86
✦ Postinstallation in an iSeries Environment on page 90
✦ Uninstalling Gentran Integration Suite from an iSeries Environment on page 94
✦ Troubleshooting: iSeries Environment on page 95

Preinstallation Setup Checklist for an iSeries Environment
The following topics will assist you with preinstallation tasks when planning to install Gentran Integration 
Suite in an iSeries environment:

✦ Key Terms on page 80
✦ Checklist for iSeries Preinstallation on page 80
✦ Checking System Requirements on page 82
✦ Downloading the JCE Distribution File on page 82
✦ Determining Port Numbers on page 83
✦ Configuring the System to View Files on page 83
✦ Mapping a Network Drive on page 84
✦ Specifying the QCCSID on page 84
✦ Creating a Gentran Integration Suite User Profile on page 84
✦ Preparing the Database on page 84
✦ Obtaining a License File on page 85
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Key Terms
The following terms and definitions will assist you in understanding the concepts that are discussed in this 
document:

✦ Java 2 Software Development Kit (JDK) – Software development kit (SDK) for producing Java 
programs. Produced by IBM, the JDK includes JavaBeans component architecture and support for 
JDBC.
Note: The Gentran Integration Suite System Requirements include information about upgrading your 
JDK for the changes enacted in 2007 for Daylight Savings Time.

✦ Gentran Integration Suite License File – Contains a license that is associated with your specific 
operating system and the IP address of your system. The license provides access, for a year, to the 
Gentran Integration Suite packages your company selected. 

✦ The Java Cryptography Extension (JCE) is a set of Java packages from IBM that provides a framework 
and implementations for encryption, key generation and key agreement, and Message Authentication 
Code (MAC) algorithms. 

✦ Gentran Integration Suite User Profile – In the iSeries environment, you must create a user profile for 
accessing the Gentran Integration Suite databases. You use this user profile when you submit the 
installation command. It is also used to start, end, and perform any system maintenance to the Gentran 
Integration Suite environment.

Checklist for iSeries Preinstallation
The preinstallation checklist contains the items you need to gather and tasks you need to complete prior to 
installing Gentran Integration Suite on iSeries.

Note: When creating a name, such as an account name, permissions name, profile name, or database name, 
follow these conventions:

The first character must be alphabetic or one of the following: $, @, or #

The remaining characters may be alphanumeric or one of the following: $, @, #, _ or .

Do not use spaces or apostrophes.

You may want to make a copy of the following checklist and use it to record the information you collect:

Step Description Your Notes

1 Verify that your system meets the hardware and software 
requirements specified for this release. See Checking 
System Requirements on page 82.

2 For systems with multiple IP addresses, verify that the IP 
address on which Gentran Integration Suite resides is 
accessible by any client computer that is running a 
browser interface.
Caution: If you do not verify the IP addresses, your 
system may not operate properly after installing Gentran 
Integration Suite.
Sterling Commerce, Inc. 80



Preinstallation Setup Checklist for an iSeries Environment
3 Verify that all client computers are using Microsoft 
Internet Explorer 5.x or later.

4 If you are using a non-English environment, confirm that 
you are using the appropriate character set.

5 Configure the system to view Gentran Integration Suite 
files using Windows Explorer. See Configuring the 
System to View Files on page 83.

6 Map a network drive to your working directory. See 
Mapping a Network Drive on page 84.

7 Specify the QCCSID (Coded Character Set) under which 
Gentran Integration Suite will run. See Specifying the 
QCCSID on page 84.

9 Determine and record the collection name for the 
database. See Preparing the Database on page 84.

10 Determine and record the passphrase you want to use 
for the Gentran Integration Suite system. 
During installation, you are prompted twice to enter the 
passphrase, which is not displayed when you type it. 

11 Determine and record information to set up default 
system alerts from Gentran Integration Suite:

The Administrative e-mail address to which system 
alert messages are sent. 

The SMTP Server IP address used for sending alert 
messages. 

12 Determine and record the initial port number to be used 
by Gentran Integration Suite. See Determining Port 
Numbers on page 83.

13 Determine and record the catalog name for the 
database. See Preparing the Database on page 84.

14 Determine the Host IP address for Gentran Integration 
Suite. This is required even if you only have one IP 
address for your system. To find the IP Address of your 
system:

Key in WRKTCPSTS *IFC

Locate and record the IP address to use for Gentran 
Integration Suite.

15 Create the Gentran Integration Suite user profile and its 
associated password. Be sure to record the user 
password so you can enter it during installation. The user 
password is not displayed when you enter it. See 
Creating a Gentran Integration Suite User Profile on 
page 84.

Step Description Your Notes
Sterling Commerce, Inc. 81



Preinstallation Setup Checklist for an iSeries Environment
Note: The Gentran Integration Suite installation program will automatically set the umask to 002 during 
the installation. However, iSeries system administrators should consider placing an appropriate 
umask command such as umask 002 in their global or user login script because the default of 000 
could allow many IFS files to be world-writable. Please consult the IBM iSeries Information Center 
for more information on umask and customizing your Qshell environment.

Checking System Requirements
Before you begin, verify that your system meets the hardware and software requirements specified for this 
release. The hardware requirements listed are the minimum required to run Gentran Integration Suite. Your 
system requirements will exceed these if you are running other applications on the same machine as Gentran 
Integration Suite.

For current information, see the System Requirements posted on the Gentran Integration Suite 
Documentation Library.

Note: Version 4.2 of Gentran Integration Suite does not require an application server for installation or at 
run-time. However, Gentran Integration Suite supports integration with JBoss™ and WebLogic®. 
You can also integrate with WebSphere®, JBoss, or WebLogic after installing version 4.2 by using 
the Gentran Integration Suite EJB Adapter.

Downloading the JCE Distribution File
The Java Cryptography Extension (JCE) is a set of Java packages from IBM that provides a framework and 
implementations for encryption, key generation and key agreement, and Message Authentication Code 
(MAC) algorithms. 

To obtain this file for the IBM JDK 1.4

16 Determine and record the absolute path to the Gentran 
Integration Suite jar file. The jar file can reside in any 
directory on your system. During installation, you use this 
directory, but this is not the final directory where Gentran 
Integration Suite resides. 

17 Record the directory in which you want to install Gentran 
Integration Suite.
The Gentran Integration Suite installation directory must 
be a new directory and cannot already exist. A large 
subdirectory tree will be created under this directory. 
During installation, this directory is referred to as the 
<install_dir>.

18 Obtain the license file and record the absolute path to the 
license file. See Obtaining a License File on page 85.

19 Obtain the JCE distribution file and record the absolute 
path to the zipped file. See Downloading the JCE 
Distribution File on page 82.

Step Description Your Notes
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1. Open your browser and navigate to 
https://www14.software.ibm.com/webapp/iwm/web/reg/pick.do?source=jcesdk.

2. Enter your IBM ID and password. If you do not have an IBM ID, follow the IBM registration 
instructions provided on the Sign In page.

3. Click Submit.
4. Select Unrestricted JCE Policy files for SDK 1.4.2 and click Continue.
5. Review your personal information and the license agreement and click I agree to continue.
6. Download the unrestrict142.zip file to your system. 
7. Once the file resides on your system, note the exact directory and file name for this zipped file. You 

will need this information during the installation process.

Determining Port Numbers
During installation, you are prompted to specify the initial port number for Gentran Integration Suite. To 
specify a port number, follow these guidelines:

✦ Gentran Integration Suite requires a range of 100 consecutive open ports between 1025 and 65535. 
✦ The initial port number represents the beginning port number in the range. 

Note: The WebDAV port is set to the initial (TCP/IP) port number plus 46. For example, if the initial 
port is 10000, the WebDAV port is 10046. This port number may be needed if you plan to set up 
WebDAV support.

✦ The port range starts with the initial port number and ends with the number that equals the initial port 
number plus 100. All ports in this range must be available for Gentran Integration Suite. For example, 
if you specify 10100, then you need to make sure that 10100 through 10199 are not used by any other 
applications on your system. 

Note: In an iSeries environment, you can view the port numbers currently in use on your system. Choose 
one of these methods:

a) Select from the iSeries Navigator Network > TCP/IP Configuration > Connections.

b) Enter WRKTCPSTS on an iSeries command line and select Option 3 (Work with TCP/IP 
connection status). Press F14 to sort the port numbers in numerical sequence.

Configuring the System to View Files
In the iSeries environment, you must configure your system to view Gentran Integration Suite files using 
Windows Explorer. Use the NetServer component of OS/400 to set up file shares that are accessible through 
Windows networking. You must set up a file share to a working directory in your iSeries Integrated File 
System (IFS).
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Mapping a Network Drive
In the iSeries environment, you must map a network drive to the working directory for Gentran Integration 
Suite. For more information, refer to the documentation on the IBM Web site.

Specifying the QCCSID
In the iSeries environment, you must specify the QCCSID (Coded Character Set) under which Gentran 
Integration Suite will run. Follow these steps:

1. From an iSeries command line, enter DSPSYSVAL SYSVAL(QCCSID).
2. Is the QCCSID set to 65535?

If Yes, then complete one of the following tasks:

• Change the CCSID to a specific coded character set:
– Enter CHGSYSVAL SYSVAL(QCCSID) VALUE(xxx), where xxx represents your coded 

character set. 
– IPL your iSeries.

• Keep the QCCSID at 65535 and specify a specific CCSID other than 65535 when you create 
your Gentran Integration Suite user profile.

Note: Refer to the IBM National Language Support Guide for valid coded character sets. It is 
recommended that you use the coded character set 037 for US English system.

If No, continue with the next preinstallation task.

Creating a Gentran Integration Suite User Profile
In the iSeries environment, you must create a user profile for accessing the Gentran Integration Suite 
databases. You use this user profile when you submit the installation command.

If your system value QCCSID is set to 65535, then set the CCSID parameter to a specific coded character 
set other than 65535 on the CRTUSRPRF command. See the IBM National Language Support Guide for 
valid coded character sets. See your operating system documentation for more information about creating 
user profiles.

Note: The job description assigned to the user profile must have a job queue defined that allows at least 
two active jobs. If the maximum number of active jobs is less than two, Gentran Integration Suite 
will not install correctly. This also applies to starting Gentran Integration Suite after installation.

Preparing the Database
In an iSeries environment, Gentran Integration Suite uses the DB2 database that is included in OS/400. 

In an iSeries environment, the installation process creates a new collection for Gentran Integration Suite. 
Before you install, you must determine and record the collection name and the catalog name.
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✦ The collection name is the name of the collection (or library) that contains the database, journal, and 
journal receiver for your Gentran Integration Suite system. The default for this prompt is GIS42DB. 
This collection must not already exist.
Note: If you are upgrading from Gentran Integration Suite 4.0, please refer to Copying a DB2 
Database in the iSeries chapter of the Gentran Integration Suite Upgrade Guide Version 4.2 (from 4.0) 
to prepare your database for the automatic upgrade. Also, during installation, answer *YES to the 
prompt Upgrade from GIS 4.0?
Note: If you are planning to upgrade from Gentran Integration Suite 3.0 or 3.1, you must answer *YES 
to the prompt Upgrade from GIS 3.0 or 3.1?

✦ The catalog name is the database name of your iSeries system, as defined by the WRKRDBDIRE 
command. Generally, this value is the name of your system.

Caution: If you are reinstalling Gentran Integration Suite, be aware that data in your existing database will 
be deleted. To prevent this, either back up the existing database or save it under a different name.

Translator Requirements for iSeries Database Files
All database files are required to be journaled when being used by the translator in Gentran Integration Suite. 
If your application files are not currently journaled, and you plan to access these files through Gentran 
Integration Suite, please refer to the IBM manuals for instructions on journaling physical files.

Obtaining a License File
After your company signed the sales contract with Sterling Commerce, Sterling Commerce created a license 
file containing information about your company, your system, and the packages (components), such as 
services, maps, and adapters, your company selected to use. 

The license file contains a license that is associated with your specific operating system and the IP address 
of your system. The license provides access, for 20 years from the date of issue, to the Gentran Integration 
Suite packages your company selected and is independent of your maintenance fee. Because the license is 
independent of your maintenance fee, the schedule for renewing your license and license file may be 
different than the maintenance fee schedule. 

You must download the license file before you can install Gentran Integration Suite. Follow these steps:

1. Point your Web browser to http://www.productupdates.stercomm.com.
2. Review the Welcome to Sterling Commerce Product Update page and click Next.
3. Review the Authenticate page and click Next.
4. Type the License File Key, which is case-sensitive, and click Next. If the system displays the Retrieve 

Registration dialog box and you are upgrading, you may retrieve your registration information by 
entering your previous License File Key. If you are not upgrading, then click Next.

5. Verify the registration information and click Next.
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6. On the Server Details page, update the fields and click Next.
If the operating system, application server, or database server version is not listed in the respective 
lists, type the version in the respective Description of Other.
All IP addresses assigned to the server in which you are installing Gentran Integration Suite should be 
listed in the license file..

7. Verify the list of packages and the type of license selected for each package and click Next. If the list 
of packages selected or the type of license selected is not correct, then contact Customer Support to 
correct the information.

8. Scroll to the bottom of the Review and Download Package License File page and click Finish and 
Download.

9. Click Save in the File Download dialog box.
10. Accept the default location for the license file or navigate to the location where you will store the 

license file. Note the absolute path of the file location on the Preinstallation Checklist. You will need 
the absolute path to install Gentran Integration Suite.

11. Click Save.
12. Close your Web browser.

Installing in an iSeries Environment
Installing Gentran Integration Suite in an iSeries environment includes the following sections:

✦ Running the Installation Program in iSeries on page 86
✦ Installing the Current Maintenance Patch on page 88
Caution: If you are upgrading, refer first to the Upgrade Guide for the release from which you are 

upgrading (3.0/3.1, 4.0 or 4.1/4.1.1). Upgrading from Gentran Integration Suite 3.0, 3.1 and 4.0 
includes a full installation of Gentran Integration Suite 4.2, but you must follow additional steps 
in the Upgrade Guide to complete the upgrade. Upgrading from Gentran Integration Suite 4.1 
and 4.1.1 does not include an installation of Gentran Integration Suite 4.2. 

Running the Installation Program in iSeries
Note: The following instructions assume that you received an installation CD for Gentran Integration 

Suite. If you downloaded Gentran Integration Suite or a Service Pack (SP) from the Electronic 
Software Distribution (ESD) Portal, unzip the downloaded file to an empty directory. The directory 
containing the unzipped files is an electronic image of an installation CD. Use this directory 
wherever there is a reference to the installation CD in the following instructions. Ignore any 
instructions to place the installation CD in a drive.

To install Gentran Integration Suite in an iSeries environment, you run an installation program. Refer to the 
information you recorded in the checklist and follow the steps below.
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Note: During the installation, various messages are displayed, including some warning messages. These 
warning messages require no action on your part and are included so that helpful data is recorded in 
the log file.

1. Insert the Gentran Integration Suite installation CD in the appropriate drive. You can use a drive on 
your PC or on your iSeries CD reader.

2. Depending on the drive you are using, choose one method. Be sure to record the absolute path that you 
use.

If the CD is in your PC, copy or FTP the file si42.jar from the installation CD to the 
<absolutepath> in the IFS root or QOpenSys file system.

If the CD is in your iSeries reader, enter the following command on the command line:

cp /qopt/si42.jar <absolutepath>/si42.jar
Note: Do not place the si42.jar directory in the root directory.  It is required to be placed in a 
subdirectory under the root directory. For example, /gisinstallitems/si42.jar

3. Copy the file gis42savf from the iSeries directory on the installation CD to the mapped network drive.
4. Is there a save file called GIS42SAVF in QGPL on your iSeries? 

If Yes, clear the save file by entering CLRSAVF FILE(QGPL/GIS42SAVF).

If No, enter CRTSAVF FILE(QGPL/GIS42SAVF) to create a save file on your iSeries.

5. Copy the gis42savf file that you copied from the CD to the save file created in QGPL by entering: 
CPYFRMSTMF 
FROMSTMF('/<directory>/<filename of the savf'>/) TOMBR('/QSYS.LIB/QGPL
.LIB/GIS42SAVF.FILE') MBROPT(*REPLACE)
CVTDTA(*NONE) 

6. Enter RSTLIB SAVLIB(GIS42) DEV(*SAVF) SAVF(QGPL/GIS42SAVF) to restore the 
installation objects.

7. From an iSeries command line, enter the following command and press Enter:
CRTDUPOBJ OBJ(FINISHG42) FROMLIB(GIS42) OBJTYPE(*PGM) 
NEWOBJ(FINISHG41)

8. Log in to your iSeries using the user profile you created during preinstallation.
9. Enter ADDLIBLE LIB(GIS42) from an iSeries command line to add the installation programs to 

your library list.
10. Enter INSTGIS42 and press F4 to prompt the command. The system displays the list of configuration 

parameters needed to install Gentran Integration Suite.
11. For each configuration parameter listed, enter the value you want to use. Refer to your notes in the 

preinstallation checklist. 

Collection

Upgrade from GIS 4.0?  Enter YES, if you are upgrading from Gentran Integration Suite 4.0. 
Otherwise, enter NO.

Upgrade from GIS 3.0 or 3.1?  Enter *YES, if you are upgrading from Gentran Integration Suite 
3.0 or 3.1. Otherwise, enter *NO.
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GIS System Passphrase

Verify GIS System Passphrase

Administrative e-mail address

IP Address for SMTP Server

TCP/IP Port Number

Catalog Name

Host IP Address

GIS User Profile

GIS User Password

12. Press Page Down for the remaining parameters:

Full Path to GIS Jar File

GIS install directory. Be sure to enter a complete path name.

Full license path name. Be sure to enter a complete path and file name.

JCE distribution file. Be sure to enter a complete path and file name.

13. Verify the parameters you entered and press Enter.
The installation process takes between 15 minutes to an hour to complete. The installation time 
depends upon the size of your iSeries. Monitor the installation process to verify that no JAVA 
exception errors are generated.
The install runs in batch mode. To monitor the progress of the install, use the WRKLNK command 
display function to view the log file (gisinstall.log). This file resides in the same directory where you 
placed the si42.jar file. In addition to the job you submitted, various BCI jobs, command shells, and 
JVMs appear and disappear in your batch subsystem. This processing is normal.

Installing the Current Maintenance Patch
Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each patch 
contains the fixes from previous patches, you only need to install the most recent patch. 

To help you determine which patch to use, the files are named using the following naming convention: 

si_engine_<build_number>.jar

For example, a file named si_engine_1976.jar is the patch for build 1976 for Gentran Integration Suite 4.1, 
which is labeled Gentran Integration Suite 4.2 in the user interface.

Information about a patch is located in a text file with a similar name. The naming convention for text files 
containing information about a particular patch is:

si_engine_<build_number>_patch_info.txt

For example, a file named si_engine_1976_patch_info.txt contains information about build 1976 for 
Gentran Integration Suite 4.1, which is labeled Gentran Integration Suite 4.2 in the user interface.
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Both the jar and the txt files are available on the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. You should periodically check the web site to verify 
that you have the most recent patch.

Note: The patch installation may use one or more patch property override files. These files will be named 
propertyFile_patch.properties. Do not alter these files. 
Additionally, property changes made directly in .properties or .properties.in files may be overwritten 
during the patch installation. Properties overridden using the customer_overrides.properties file are 
not affected.

To install the latest patch for Gentran Integration Suite in an iSeries environment, follow the steps below.

1. Go to the Sterling Commerce Support on Demand Web site, at 
https://support.sterlingcommerce.com/user/login.aspx. 

2. Download the most recent patch file for your version of Gentran Integration Suite.
3. Sign on with your Gentran Integration Suite user profile and enter into QSH (QShell mode).
4. In QSH, change to the install_dir/bin directory where <install directory> = Gentran Integration 

Suite installation directory.
Example: cd /install_dir/bin and press Enter.

5. Run the following command to install the patch:
./InstallService.sh 
<path>/si_<version>_sp_0_patch_<number>_<app_server>.jar

where:
<path> = Fully qualified path to maintenance patch file
<version> = Gentran Integration Suite Version
<number> = Patch number
<app_server> = Application Server
Example: InstallService.sh /installdir/si_22_sp_0_patch_1_jboss.jar
Information about the Patch installation is automatically logged to install_dir/logs/InstallService.log.
If the patch attempts to modify the database schema and the modification fails, you will receive an 
error message about the failure. The message will provide the error message code from the database 
and the SQL command that failed. The failure information is also logged to the system.log file and to 
the patch.log file. If you cannot determine whether the failure can be safely ignored, contact Sterling 
Commerce Customer Support for assistance. Choose one of the following options when prompted:

Continue – If you determine that the failure can be safely ignored, continue with the patch 
installation.

Stop – Stop the patch installation. You should always contact Sterling Commerce Customer 
Support for assistance before choosing this option.

Retry – Choose this option to retry the failed command.
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Postinstallation in an iSeries Environment
After installing Gentran Integration Suite, you should complete the following tasks:

✦ Starting Gentran Integration Suite on page 90
✦ Accessing Gentran Integration Suite on page 91
✦ Validating the Installation on page 92
✦ Downloading Gentran Integration Suite Tools on page 93
✦ Performing Initial Administrative Setups in Gentran Integration Suite on page 93
✦ Stopping Gentran Integration Suite on page 93

Starting Gentran Integration Suite
To start Gentran Integration Suite in an iSeries environment, follow these steps:

1. Sign onto iSeries with your Gentran Integration Suite user profile.
2. Submit a batch job by entering the following command:

SBMJOB CMD(QSH CMD('umask 002 ; cd install_dir/bin ; ./run.sh')) JOB(SIMAIN) 

Note: The job queue to which you submit the command must allow at least two active jobs. If the 
maximum number of active jobs is less than two, Gentran Integration Suite will not start up 
completely.

To reduce keying errors at startup, create a command language (CL) program similar to the following 
example:
PGM
SBMJOB CMD(QSH CMD('umask 002 ; cd install_dir/bin ; ./run.sh')) +
JOB(SIMAIN)
ENDPGM

3. Wait for startup to complete, a process that takes 10 to 15 minutes. 
4. Startup creates a spool file. When startup is finished, open the QPRINT spool file and check the end of 

the file for a message about how to connect to Gentran Integration Suite. For example, you may see a 
message like the following:
Open your Web browser to http://host:port/dashboard, where host:port is the IP address and port 
number where Gentran Integration Suite resides on your system.
Make a note of the address so you can access Gentran Integration Suite later.
Note: It may take several minutes for Gentran Integration Suite to be available from the Web browser, 
even after the above URL message has been issued.

5. Optional. To verify that Gentran Integration Suite has started normally and completely, view the 
system through WRKACTJOB and verify that only two QP0ZSPWP jobs (of yours) are left running in 
your GIS batch subsystem.
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6. Prepare your browser to log in to Gentran Integration Suite. Configure your browser so that there is 
direct connection between the Web browser and iSeries. Do not configure the browser to use any 
proxy server between you and iSeries (unless it is a requirement of your network).

Accessing Gentran Integration Suite
To log in to Gentran Integration Suite the first time, follow these steps:

1. Be sure that Gentran Integration Suite is started and running.
2. Open a browser window and enter the address displayed at the end of startup.
3. The login page for Gentran Integration Suite displays. 
4. Type the default user ID and password. The default login is at an administrative level. One of your first 

tasks as an administrator is to change the administrative password and to register other users with other 
levels of permission.

Technical Note: Changes to Network Interface Bindings
To increase the security of the Administrator Console user interface, Gentran Integration Suite Version 4.2 
binds only to specific network interfaces. By default, previous versions had been bound to all network 
interfaces. After installing, if the URL for Gentran Integration Suite returns Page cannot be displayed, you 
can adjust property settings to correct the problem.

1. On the server where Gentran Integration Suite resides, edit the file noapp.properties.in.
a. Locate the admin_host parameter. The default settings are as follows:

hostname1 is the name of primary network interface, the one given highest priority by Gentran 
Integration Suite.
localhost is the name of the network interface on the server where Gentran Integration Suite 
resides.
Default entries
admin_host.1    = hostname1
admin_host.2    = localhost

System Default login

Gentran Integration Suite User ID: admin
Password: password

AS2 Edition User ID: as2_user
Password: password

UCCnet Edition User ID: uccnet_user
Password: password
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b. Correct the parameters.
If no interface is being displayed, edit hostname1 so that it correctly identifies the primary network 
interface that accesses Gentran Integration Suite.
If an additional network interface needs to access Gentran Integration Suite, add an additional 
admin_host entry, as shown below. 
Edited entries
admin_host.1    = hostname1
admin_host.2    = localhost
admin_host.3    = hostname2

2. Stop Gentran Integration Suite.
3. Run the setupfiles.sh utility located in the install_dir/bin directory.
4. Restart Gentran Integration Suite.

For the Dashboard user interface, Gentran Integration Suite Version 4.2 provides unrestricted binding to 
network interfaces through the perimeter server. To restrict access to the Dashboard user interface, you can 
adjust property settings so that only one network interface accesses Gentran Integration Suite. 

1. On the server where Gentran Integration Suite resides, edit the file perimeter.properties.in.

a. Locate the localmode.interface parameter. The default setting is unrestricted, as shown below. 
Unrestricted Setting (Default)
localmode.interface=*

b. To restrict access to the Dashboard, enter the network interface that you want Gentran Integration 
Suite to support.
Restricted Setting
localmode.interface=hostname1

2. Stop Gentran Integration Suite.
3. Run the setupfiles.sh utility located in the install_dir/bin directory.
4. Restart Gentran Integration Suite.

Validating the Installation
After you install, start, and log in to Gentran Integration Suite the first time, you can validate the installation 
by testing a sample business process. Follow these steps:

1. Open a browser window and enter the address for Gentran Integration Suite. This address was 
displayed at the end of startup.

2. Enter your user login and password. 
3. From the Administration menu, select Business Processes > Manager.
4. In the Process Name field, type Validation_Sample_BPML and click Go!
5. Click execution manager.
6. Click execute.
7. Click Go! The Status: Success message displays in the upper left side of the page.
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Downloading Gentran Integration Suite Tools
Gentran Integration Suite includes four tools that run on a desktop or personal computer. After you install, 
start, and access Gentran Integration Suite, you can install the following tools by downloading them from 
within Gentran Integration Suite: 

✦ Map Editor and associated EDI and CII standards
✦ Graphical Process Modeler
✦ Web Template Designer
✦ Service Developer’s Kit

Performing Initial Administrative Setups in Gentran Integration Suite
If you are installing Gentran Integration Suite for the first time, you need to perform some initial 
administrative setups before users can use the application. For example, the system administrator for 
Gentran Integration Suite must register users, grant permissions, and run several performance reports so that 
benchmarks are established for tuning the system in the future. 

Stopping Gentran Integration Suite
To stop Gentran Integration Suite in an iSeries environment, follow these steps: 

1. Sign onto iSeries with your Gentran Integration Suite user profile. 
2. Enter the following commands: 

QSH
cd install_dir/bin
./hardstop.sh
Note: To reduce keying errors at shutdown, create a command language (CL) program similar to the 
following example:
PGM
QSH CMD('cd install_dir/bin ; ./hardstop.sh')
ENDPGM 

3. Wait for shutdown to complete. The length of this process is determined by how many temporary 
objects must be cleaned up and how many spool files must be created. 
To ensure that you do not restart Gentran Integration Suite before shutdown is complete, monitor 
shutdown through either the ps command in Qshell or the WRKACTJOB display. Verify that the two 
QP0ZSPWP jobs are complete and disappear. 
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Uninstalling Gentran Integration Suite from an iSeries 
Environment
When you uninstall, the Gentran Integration Suite application is automatically removed from the server.

Additionally, you can manually remove Java WebStart and any desktop tools that were downloaded.

To uninstall Gentran Integration Suite from an iSeries environment, follow these steps:

1. Stop Gentran Integration Suite and wait for shutdown to complete.
2. Sign onto iSeries with your Gentran Integration Suite user profile. 
3. In QSH, change to the directory above install_dir. 

Example:
If the install directory is /GIS42, then you change to directory /.

4. Enter rm –rf install_dir. 
Example:
rm –rf GIS42

5. Wait for the command prompt to return. 
6. Select F3 exit from Qshell.
7. Enter DLTLIB <collection name>.

Example:
DLTLIB GIS42DB
A message like the following is displayed: Receiver QSQJRN0001 in GIS42DB never fully saved. (I 
C).
Enter I to one or more of these messages until the library is deleted.

8. After you remove Gentran Integration Suite from the server, you can remove Java WebStart and any 
tools that were downloaded to the desktop:

Map Editor and associated EDI and CII standards

Graphical Process Modeler

Web Template Designer

Service Developer’s Kit
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Situation Message or Symptom Explanation/Resolution

Installing Cannot find the license file that was 
downloaded as a preinstallation task.

Explanation
The license file is located on a personal computer rather than 
the server. 
Resolution
Save the license file to the server using the mapped network 
drive.

Starting Invalid or corrupt license file. Explanation
Either the license file was altered or was not downloaded prior 
to starting Gentran Integration Suite.
Resolution
Download your license file from 
http://www.productupdates.stercomm.com. See Obtaining a 
License File on page 85.

Accessing Attempts to access the URL for 
Gentran Integration Suite display the 
message: Page cannot be displayed.

See Accessing Gentran Integration Suite on page 91.

Stopping Ending jobs from Gentran Integration 
Suite when a hardstop is not 
successful.

Explanation
There was a problem during the installation process or the 
subsystem was not defined correctly.
Resolution
1 Key in WRKACTJOB and locate the job that didn't end 

successfully. 
2 Press F11 twice to obtain the job number that you want 

to end.
3 Press F3 to end the WRKACTJOB panel.
4 Key in QSH to enter Qshell mode.
5 Key in ps and press Enter.
6 Locate the pid number that corresponds to job number 

from the WRKACTJOB panel.
7 Key in kill -kill <pid number>
8 Review the install log to determine the error and 

resolution. If the error is due to:

A problem with the installation of Gentran Integration 
Suite, then delete the <install_dir> and install Gentran 
Integration Suite again.

The job queue having 1 as the maximum number of active 
jobs in the subsystem, then either change the subsystem 
that you start Gentran Integration Suite in, or change the 
number of maximum active jobs.
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Chapter 4

Installing and Configuring MESA Developer
Studio

This section includes the following topics:

✦ Overview for Installing and Configuring MESA Developer Studio on page 96
✦ Configuring J2SE on Your PC on page 98
✦ Verifying that MESA Developer Studio Uses the Correct JRE on page 98
✦ Starting the WebDAV Server on page 99
✦ Installing MESA Developer Studio Components on page 100
✦ Setting Up a Gentran Integration Suite Instance on page 101
✦ Installing Additional MESA Developer Studio Components and Updates on page 103

Overview for Installing and Configuring MESA Developer 
Studio
Gentran Integration Suite MESATM Developer Studio is an Integrated Development Environment (IDE) 
that uses Eclipse software plug-ins. Use the MESA Developer Studio to connect with a Gentran Integration 
Suite instance for resource access and control of operations of Gentran Integration Suite, change the 
template Gentran Integration Suite uses, and develop custom services, all from within a development 
environment.

Note: MESA Developer Studio is not supported in the iSeries platform.

In addition to MESA Developer Studio, the following plug-ins are available:

✦ MESA Developer Studio SDK – for developing and deploying custom services and adapters.
✦ MESA Developer Studio Skin Editor – for customizing the look and feel of the Gentran Integration 

Suite interface.
✦ Reporting Services – a separately-licensed set of plug-ins used to create fact models and reports for 

Gentran Integration Suite Reporting Services.
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Assumptions and Prerequisites
Read the following assumptions and prerequisites prior to installing MESA Developer Studio:

✦ Basic knowledge of Gentran Integration Suite and its architecture. This is especially important if you 
are using MESA Developer Studio SDK to create services and adapters. For more information, see the 
MESA Developer Studio documentation.

✦ Basic knowledge of Eclipse is assumed. For more information, see the Eclipse online help or go to 
http://www.eclipse.org.

✦ Extensive knowledge of how to create and deploy a service. For more information, see the MESA 
Developer Studio documentation.

✦ Thorough knowledge of and experience with the Java programming language for creating services.
✦ You have the required MESA Developer Studio (and if purchased, Reporting Services) product 

licensing.

Steps to Set Up MESA Developer Studio
Setting up MESA Developer Studio is a multi-step process which should be completed in the order 
described. The following is a checklist for each stage in the process. The checklist provides an overview of 
the entire process. Separate instructions for completing each step are available:

1. Install and configure Gentran Integration Suite 4.2.
2. Download and install the latest Gentran Integration Suite patch.
3. Download and install a full release version of Eclipse 3.1. For more information, see 

http://eclipse.org/downloads/index.php.
Note: MESA Developer Studio requires specific plug-in versions. We recommend you to install 
Eclipse for MESA development only. If you are using Eclipse with development projects other than 
MESA, disable plug-ins that report conflicts.

4. Download and install the latest version of JavaTM 2 SDK Standard Edition 1.4.2_06 (or higher) on the 
same PC that you installed Eclipse 3.1. It is important that you have the full SDK and not just the JRE. 
After installation, additional configuration is required. For information on configuring the J2SE 
environment on your PC, see Configuring J2SE on Your PC on page 98.

5. Verify that MESA Developer Studio uses the correct JRE. For more information, see Verifying that 
MESA Developer Studio Uses the Correct JRE on page 98.

6. Start the WebDAV server (for Gentran Integration Suite installations on UNIX only). See Starting the 
WebDAV Server on page 99.

7. Install the MESA Developer Studio (and if purchased, Reporting Services) Plug-ins. For more 
information, see Installing MESA Developer Studio Components on page 100.

8. Set up a Gentran Integration Suite Instance in MESA Developer Studio. For more information, see 
Setting Up a Gentran Integration Suite Instance on page 101.

9. Set up Gentran Integration Suite resources to be used with MESA Developer Studio. For more 
information, see the MESA Developer Studio documentation.
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Configuring J2SE on Your PC
Eclipse Terms
The following Eclipse terms might be used in this documentation when describing MESA Developer Studio 
components:

✦ Project - All the resources related to a particular implementation reside in a project. It can contain 
folders, files, and other Eclipse objects. 

✦ Workspace - Directory where work is stored.
✦ Workbench - UI window that contains these elements:

Perspective - group of views and editors in a Workbench window that correspond to a certain 
project. 

View - visual component within the Workbench and dependent on the perspective that was 
selected. Used to navigate or display information such as properties or messages.

Editors - visual component in the Workbench used to create, change, or browse a resource.

Configuring J2SE on Your PC
In order for Eclipse to work correctly, you must have Java 2 SDK Standard Edition 1.4.2_06 (or higher) 
installed on the same PC you installed Eclipse 3.1. You need to have the full SDK installed. The JRE alone 
is not enough. You must close Eclipse to download and install the JDK. After installing J2SE, you must 
configure your PC to use it.

To configure your PC for the new JDK:

1. From the Windows Start menu, select Settings > Control Panel > System. 
2. Click the Advanced tab.
3. In the Environment Variables section, click Environment Variables.
4. In the System Variables section, click New.
5. Complete the following and click OK:

Variable Name - type JAVA_HOME.

Variable Value - type the directory path for the location where you installed the J2SE SDK. The 
default location is C:\j2sdk1.4.2_06\.

6. Click OK to exit.

Verifying that MESA Developer Studio Uses the Correct JRE
In addition to adding a home directory on Windows for this JDK instance, you must also verify that MESA 
Developer Studio uses the correct JRE.

To verify the MESA Developer Studio JRE:
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1. Open Eclipse.
2. From the Window menu, select Preferences.
3. Expand the Java section and select Installed JREs. The Installed JREs window appears.
4. If C:\j2sdk4.2.4_06 is not listed (location and version may be different, but version should be as listed 

or higher), click Add and go to next step.
If it is listed, make sure it is selected and click OK. You are ready to use MESA Developer Studio.

5. Complete the following and click OK:

JRE Name - type any name for this JRE.

JRE home directory - click Browse to select the home directory you defined in Configuring J2SE 
on Your PC on page 98.

Default VM Arguments - leave blank.

JRE system libraries - make sure Use default system libraries is selected.

6. Click OK to exit.

Starting the WebDAV Server
MESA Developer Studio uses a WebDAV server as the datastore that provides access to Gentran Integration 
Suite resources, including MESA Developer Studio plug-in updates. This WebDAV server is automatically 
installed with Gentran Integration Suite 4.2 for use with MESA Developer Studio. 

While the WebDAV server starts automatically with Gentran Integration Suite Windows, you must start the 
WebDAV server manually with Gentran Integration Suite UNIX. For specific instructions, see the 
following sections.

Gentran Integration Suite Windows
The WebDAV server that is used with MESA Developer Studio is implemented as a service, and starts 
automatically when you start Gentran Integration Suite (startWindowsService.cmd). When Gentran 
Integration Suite is stopped (stopWindowsService.cmd), the WebDAV server, and MySQL if used, remains 
running. This is necessary to start and stop instances of Gentran Integration Suite from within Eclipse and 
MESA Developer Studio.

You can stop the WebDAV Server Service using the stopWebdavWindowsService.cmd. Also, when 
Gentran Integration Suite and WebDAV Server Service are running and WebDAV Server Service gets 
stopped Gentran Integration Suite (and MySQL if used) will remain running. The logfilename of the 
WebDAV Server Service is webdav.log (not gisdav.log as in UNIX).

Gentran Integration Suite UNIX
You do not need to have Gentran Integration Suite running to start the WebDAV server.

Note: You must start the WebDAV server for each Gentran Integration Suite instance you want to work 
with in MESA Developer Studio.
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To start the WebDAV server:

1. Open a UNIX command window.
2. Go to the Gentran Integration Suite install directory. This is usually installDir/bin.
3. Start the WebDAV server by executing the ./runDAVServer.sh command.
4. You are asked to enter your installation password. You must enter this information only once for each 

Gentran Integration Suite installation because the password is written permanently to the properties 
file. This step is optional, however if you do not enter the password you will not be able to start and 
stop Gentran Integration Suite instances from MESA Developer Studio.

5. After the startup process is complete, the WebDAV port is listed. Make a note of this number. Format 
is base install port + 46. The WebDAV port is needed when requesting to download and install the 
MESA Developer Studio plug-ins.

Note: The default WebDAV port is the base install port + 46. This port is assigned when you install 
Gentran Integration Suite and should not be changed. The WebDAV port number is used when 
installing the plug-ins and when adding a Gentran Integration Suite instance to MESA Developer 
Studio. For more information, see Setting Up a Gentran Integration Suite Instance on page 101.

Installing MESA Developer Studio Components
You must install and configure MESA Developer Studio to connect with the desired Gentran Integration 
Suite instances for resource access and for control operations of Gentran Integration Suite from within 
MESA Developer Studio. Use this procedure to install Reporting Services plug-ins, as well.

Changing Proxy Preferences
You might need to change you proxy server settings to enable an HTTP proxy connection between the PC 
where you have Eclipse installed and the server where Gentran Integration Suite is installed. 

To change proxy settings:

1. From the Windows menu, select Preferences > Install/Update. 
2. Under Proxy settings, type your proxy information.
3. Click OK.

Installing New Features
To install MESA Developer Studio:

1. Open Eclipse. 
2. Select a default workspace folder location. You can add additional workspace folder locations at any 

time. The Package View in the lower left area of the MESA Developer Studio workspace displays a 
local explorer view of your project folders. This enables you to store files that you check out.
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3. From the Eclipse Help menu, select Software Updates > Find and install.
4. Select Search for new features to install.
5. Click Next.
6. Click New Remote Site.
7. Complete the following information and click OK.

Name – type a descriptive name for the application server.

URL – type the IP address or name of your server. Format is 
http://<servername>:<WebDAVportnumber>/eclipse. 

Your new site will appear in the list of sites to include in the search.
8. Select the check-box to the left of the new site. Click Finish. 

The system verifies the selected site and displays the results. On the search results page, expand the 
update site node and select from the following plug-ins, according to your licenses:

MESA Developer Studio 

Service SDK

Skin Editor

Reporting Services (automatically selects all three Reporting Services plug-ins: Fact Model 
Editor, Report Editor, and Report Format Editor)

Cautions: 

Do not change the default installation path for the plug-ins.

If you are selecting Reporting Services, you must also select the MESA Developer Studio plug-in 
(unless you have already installed MESA Developer Studio). Dependencies require that the 
MESA Developer Studio plug-in be installed either before or at the same time as the Reporting 
Services plug-ins.

9. Click Next. Accept the terms of the license and click Next.
10. Click Finish.
11. Click Install All to accept the feature verification.

You must restart Eclipse for the changes to take affect.

Setting Up a Gentran Integration Suite Instance
You can only view resources that are available for the specified Gentran Integration Suite instance. If a 
desired resource resides in a different Gentran Integration Suite installation you must configure a new 
instance in MESA Developer Studio to work with it.

Note: If you are installing Reporting Services, you must complete this task. 
1. From the Window menu, select Open Perspective > Other.
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2. Select MESA Developer Studio and click OK. 
3. In the MESA Developer Studio view in the upper left, right-click and select New instance. 
4. Complete the following information and click Finish: 

Hostname - name of machine for Gentran Integration Suite install.

Port - WebDAV port assigned at install (see Starting the WebDAV Server on page 99).

Name - name you assign to this Gentran Integration Suite connection.

User name - valid Gentran Integration Suite user name (for example, admin).

Password - valid Gentran Integration Suite password.

MESA Developer Studio attempts to establish a connection to the instance using the WebDAV server. 
The status of the instance is displayed:

Red – the instance has not been started.

Yellow – the instance was started but is not yet running.

Green – the instance is running.

Note: Refresh the workspace to see a newly added environment.

Editing Connection Information
Once you have set up a Gentran Integration Suite instance for use with MESA Developer Studio, you can 
edit the connection information, view configuration details, test the connection, and refresh the connection.

To edit the connection information:

1. Right-click on the instance name.
2. Select Edit. 
3. Edit the settings as needed.
4. Click Finish.

MESA Developer Studio attempts to establish a connection to the instance using the new information. 
The status is displayed (green, yellow, or red) according to the status of the instance.

Viewing Configuration Details
To view configuration details, double-click on the instance name. 

Note: The ports on the Overview window are static. Only the ports present at the installation are displayed. 
Any changes or additions made after installation are not displayed.

Refreshing the Instance
Use Refresh if you have locked or unlocked business processes and maps through in Gentran Integration 
Suite, and you want to see their current status in MESA Developer Studio.
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To refresh the Gentran Integration Suite instance connection:

1. Right-click on the instance name.
2. Select Refresh.

The Progress Information window appears and closes automatically when the refresh process is 
complete. The status is displayed (green, yellow, or red) according to the status of the instance.

Installing Additional MESA Developer Studio Components and 
Updates
You can install additional MESA Developer Studio components not installed at the time of the original 
installation at any time. To install additional components follow the steps listed in Installing MESA 
Developer Studio Components on page 100. The system verifies that the license file has newly licensed 
components and installs them.

The system verifies that the additional components are licensed in Gentran Integration Suite. If not, you are 
asked to provide new connection parameters to a Gentran Integration Suite instance that has the appropriate 
license for the additional MESA Developer Studio components. Once the license check is complete, the new 
components are activated.

If you are updating an existing component, restart Eclipse in order for the new component to be updated.

Installing Reporting Services Plug-Ins
Reporting Services works with Gentran Integration Suite MESA Developer Studio, which is an an 
Integrated Development Environment (IDE) that uses Eclipse software plug-ins. The Reporting Services 
Fact Model Editor, Report Editor, and Report Format Editor are all accessed as Eclipse plug-ins.

Note: Reporting Services are not supported in the iSeries platform.

To set up the Reporting Services plug-ins:

1. Follow the procedures for the MESA Developer Studio configuration. See Steps to Set Up MESA 
Developer Studio on page 97 for the complete list of tasks and the correct order of completion. 
Note: When completing the procedure Installing MESA Developer Studio Components on page 100, 
ensure that you select both the Reporting Services plug-ins and the MESA Developer Studio plug-in 
for download and installation in Eclipse. 
Caution: The MESA Developer Studio plug-in is a prerequisite for the Reporting Services plug-ins. 
You must install it either with or prior to installing the Reporting Services plug-ins. 
After installing the MESA Developer Studio and Reporting Services plug-ins, complete the following 
tasks:

2. Start the WebDAV server for your Gentran Integration Suite instance. See Starting the WebDAV 
Server on page 99. 

3. Start the Event Listeners.
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4. Configure your Eclipse installation to point to the Gentran Integration Suite WebDAV server. See 
Setting Up a Gentran Integration Suite Instance on page 101. 

5. Customize the Window Perspective in Eclipse to include Sterling Commerce Reporting Services. This 
makes the Reporting Services options available directly from the Eclipse menus. In Eclipse, select 
Window > Customize Perspective. In the Shortcuts pane on the left, select Sterling Commerce 
Reporting Services and click OK. 
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Appendix A

Configuring Gentran Integration Suite for a
Non-English Environment

You can install Gentran Integration Suite in an English or a non-English environment on the following 
operating systems:

✦ UNIX or Linux
✦ Windows
✦ iSeries
By modifying a few system settings, you can then configure Gentran Integration Suite for your locale.

This section includes the following topics:

✦ Configuring Encodings for Gentran Integration Suite on page 105
✦ Configuring Locales on page 107

Configuring Encodings for Gentran Integration Suite 
Language settings for Java applications involve both character sets and encoding:

✦ A character set is a set of characters (letters, numbers, and symbols such as #, $, and &) that are 
recognized by computer hardware and software.

✦ An encoding is a representation of data in a particular character set. An encoding set is a group of 
encodings. 
For information about basic and extended encoding sets, see 
java.sun.com/j2se/1.4.2/docs/guide/intl/encoding.doc.html.

The default encoding for Gentran Integration Suite is 8-bit Unicode Transformation Format (UTF-8). 

Gentran Integration Suite provides two property files that contain supported encoding sets. These properties 
files reside in the install_dir/properties directory.

✦ encodings.properties – Contains the default encoding set used in the Gentran Integration Suite 
interface.

✦ encodings_large.properties – Contains all supported encoding sets.
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Configuring Encodings for Gentran Integration Suite
The default encoding set in Gentran Integration Suite includes the following encodings:

✦ UTF-8
✦ IS0-8859-1
✦ ISO-8859-5
✦ US-ASCII
✦ ISO_8859-1
✦ EUC-JP
✦ UTF-16
✦ ISO-2022-JP
You are not limited to the encodings in the encoding.properties file. Gentran Integration Suite enables you 
to configure the encodings properties files to expand the number of encodings you can use.

To configure your encoding set:

1. Stop Gentran Integration Suite and wait for shutdown to complete.
2. Change to the install_dir/properties directory.
3. Open the encodings_large.properties file. Select the encodings you want to add to the 

encodings.properties file.
4. Open the encodings.properties.in file.
5. At the end of the encodings.properties.in file, add the encodings you selected from the 

encodings_large.properties file. When adding encodings from one file to the other, first copy the 
encodings as they appear in the encodings_large.properties file. After adding the new encodings, 
ensure that the index numbers are consecutive. If the index numbers are not consecutive, change the 
index number or numbers as needed. For example, encoding54 cannot follow encoding6. In this 
example, change encoding54 to encoding7.
The first name in the definition (before the comma) is the name that will appear in the Gentran 
Integration Suite user interface. You can change this name to make it more descriptive. For example:

encoding4 = 819,ISO8859_1

may be changed to

encoding4 = WesternEurope,ISO8859_1

ISO8859_1 is the Java canonical name and should not be changed.
6. Update the first line in the encodings.properties.in file (numberof). Change numberof to the number of 

encodings added to the file. For example, if the current value is numberof = 6 and you add 5 new 
encodings, the new value is numberof = 11.
numberof indicates the total number of encodings located in the file. You must update numberof to 
ensure that the encodings you added will be visible in the user interface.

7. Change to the install_dir/bin directory.
8. Run the setupfiles.sh script or the setupfiles.cmd script (Windows only).
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9. Start Gentran Integration Suite. 

Configuring Locales
Gentran Integration Suite runs in any locale that Java supports. If you want to run Gentran Integration Suite 
in a non-default locale, then configure your environment to the specific locale you want to use. 

Note: To configure your operating system as a non-English environment, consult your operating system’s 
documentation.

To determine and set the locale in a UNIX or Linux environment:

1. Enter locale -a. A list of locales is displayed.
2. Set your locate by entering:

export LANG <locale> 

export LC_ALL <locale> 

Example to set the locale to Japanese (on Solaris): 

• export LANG ja_JP
• export LC_ALL ja_JP

Note: Some UNIX shells require the setenv command instead of the export command.

To determine and set your locale in a Windows environment:

1. Select Control Panel > Regional Options > General tab.
2. From the Your locale (location) list, select the language and location. 
3. Click Set Default and select the locale from the Set the appropriate locale list.
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Appendix B

Using Gentran Integration Suite with
Gentran:Server for UNIX

You can configure Gentran Integration Suite to run with Gentran:Server for UNIX.

This section includes the following topics:

✦ About Gentran:Server for UNIX and Gentran Integration Suite on page 108
✦ Installing and Configuring Attunity® Data Connect on page 109
✦ Configuring Gentran Integration Suite to Run with Gentran:Server for UNIX on page 110

About Gentran:Server for UNIX and Gentran Integration Suite
Gentran Integration Suite has the ability to access information located in Gentran:Server for UNIX version 
5.3 or 6.0. The following restrictions apply:

✦ You must be using Gentran Integration Suite in one of the following environments:
UNIX

Linux

✦ You must be using one of the following Gentran:Server for UNIX product levels:
Gentran:Server for UNIX with Process Control Manager (PCM)

Gentran:Server for UNIX with EC Workbench (ECW)

Gentran:Server for UNIX with Advanced Data Distribution (ADD)

By configuring Gentran Integration Suite to run with Gentran:Server for UNIX, you can:

✦ View data from your Gentran trading partners.
✦ Start or stop Gentran:Server data managers and view which data managers are running.
✦ View, search, and track Gentran:Server for UNIX Life Cycle event records.
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Installing and Configuring Attunity® Data Connect
You can configure Gentran Integration Suite with Gentran:Server for UNIX either immediately following 
installation or at a later date. When you configure Gentran Integration Suite with Gentran:Server for UNIX, 
you only need to configure the features relevant to what you want to use:

✦ In Gentran:Server for UNIX, configure trading partners and the Gentran Life Cycle.
✦ In Gentran Integration Suite, configure tracking and operations.

Installing and Configuring Attunity® Data Connect 
If you want Gentran Integration Suite to use the trading partner information in your Gentran:Server for 
UNIX system, you must install and configure Attunity Data Connect. However, if you plan to convert your 
trading partner data from Gentran:Server for UNIX format to Gentran Integration Suite format, skip this 
section.

Attunity Data Connect is third-party software that enables you to view your Gentran trading partners’ data. 
The Attunity Data Connect software provides JDBC access to the Gentran DISAM database fields where 
the trading partner information is stored. 

To configure Attunity Data Connect:

1. Install Attunity Data Connect 3.3 or later using the installation procedures provided with the Attunity 
Data Connect software.

2. Ensure that Attunity Data Connect runs as expected. 
3. Create a new DISAM data source and refresh the Attunity Data Connect server. For more information, 

see the Attunity Data Connect documentation.
4. Locate the following metadata description files in the install_dir/tp_import/gentran/disam_mapping 

directory.

TP_MAST.XML

TRADACOM.XML

ORGANIZATION.XML

TP_MISC.XML

5. In each file listed in Step 4, replace the string $YOUR_DATASOURCE with the name of the data 
source for your Gentran:Server for UNIX system.

6. In each file listed in Step 4, replace the string YOUR_GENTRAN with the path to the root directory 
of Gentran:Server for UNIX. 

7. Run the Attunity Data Connect Dictionary (ADD) Editor.
8. Select the DISAM data source you created in step 3.
9. Import the metadata description files you updated in steps 5 and 6.

For information about importing XML metadata description files, see your Attunity Data Connect 
documentation.

10. Verify that the imported metadata description files are included in the list of tables. 
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11. Save your changes.
12. Exit the Attunity Data Connect Data Dictionary (ADD) Editor.

Configuring Gentran Integration Suite to Run with 
Gentran:Server for UNIX
To configure Gentran Integration Suite to run with Gentran:Server for UNIX:

1. Set the Umask to 002 in Gentran Integration Suite.
2. Is Gentran Integration Suite installed on a different computer than Gentran:Server for UNIX?

If Yes, then NFS mount the $EDI_ROOT of Gentran:Server for UNIX onto the Gentran 
Integration Suite host.

If No, then continue with Step 3.

3. Verify that the remote shell (rsh or remsh) is working.
If you are unable to use the rsh/remsh shell and can only use the ssh shell, change the GS_RSHELL 
variable, located in the sandbox.cfg file, when you configure Gentran Integration Suite to run with 
Gentran:Server for UNIX. 

4. Change directory in Gentran Integration Suite to install_dir/bin.
5. Run ./softstop.sh to stop Gentran Integration Suite.
Caution: Running softstop.sh command in a multiple node (clustered) environment will suspend all 

scheduled business processes.  It is recommended to run the hardstop.sh command when 
stopping individual nodes of a cluster.

6. Run ./configGSUnix.sh to begin configuring Gentran Integration Suite to run with Gentran:Server for 
UNIX.

7. Press Enter to continue configuring Gentran Integration Suite to run with Gentran:Server for UNIX.
8. Do you want to configure Tracking and Ops using the Gentran Integration Suite interface?

If Yes, go to step 9.

If No, go to step 15.

9. Are you currently using Gentran Life Cycle?
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If Yes, select the appropriate database you are using with Gentran:Server for UNIX and enter the 
following database information:
• Database vendor
• Absolute path of the JDBC drivers
• Database user name 
• Database password
• Database (catalog) name
• Database host name using either the IP address or name of the computer where the database is 
installed
• Database port number

If No, go to step 10.

10. Is Gentran:Server for UNIX installed on the same computer as Gentran Integration Suite?

If Yes, enter EDI_ROOT for the local computer, and go to step 14.

If No, go to step 11.

11. Enter the host name of the computer where Gentran:Server for UNIX is installed.
12. Enter the EDI root where Gentran:Server for UNIX is locally mounted. 
13. Verify the EDI root for the computer where Gentran:Server for UNIX is installed. 
14. Indicate which version of Gentran:Server for UNIX is currently installed.

For version 5.3, enter 1.

For version 6.0, enter 2.

If you press Enter without making a selection, version 6.0 is selected as the default.
15. Do you want to configure Gentran Integration Suite so that you can view Trading Partner 

Administration?

If Yes, enter the following Gentran:Server for UNIX database information:

• Absolute path for the JDBC drivers (/attunity_install_dir/java)
• Database user name
• Database password
• Host name where Attunity Data Connect is installed
• Database name
• Attunity database port

If No, go to step 16.

16. Do you want to continue with the installation?

If Yes, enter yes to start configuring Gentran:Server for UNIX with Gentran Integration Suite:
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If No, enter no to cancel the installation.

After the installation completes, the following message displays, Deployment to the application server 
successful.

17. Enter run.sh.
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